
Министерство образования и науки Российской Федерации 
 
 

Федеральное государственное бюджетное образовательное учреждение 
высшего профессионального образования 

«Оренбургский государственный университет» 
 
 
 

С. В. Каменев, К. В. Марусич 
 
 
 
 

КОМПЬЮТЕРНОЕ МОДЕЛИРОВАНИЕ И 
ОБРАБОТКА ДАННЫХ В ПРИКЛАДНЫХ 

НАУЧНЫХ ИССЛЕДОВАНИЯХ 
 
 
 
 
 
 
 

Рекомендовано Ученым советом федерального государственного 
бюджетного образовательного учреждения высшего профессионального 
образования «Оренбургский государственный университет» в качестве 
учебного пособия для студентов, обучающихся по программам высшего 
профессионального образования по направлениям подготовки 151900 
Конструкторско-технологическое обеспечение машиностроительных 
производств, 221000.62 Мехатроника и робототехника, 160400 Ракетные 
комплексы и космонавтика и 160100.68 Авиастроение. 
 
 
 
 
 
 
 
 

Оренбург 
2013 



2 

УДК 001.891:004(075.8) 
ББК 72.4я7+32.973-018я7 

К18 
 
 

Рецензент – профессор, доктор технических наук А. И. Сердюк 
 
 
 
        Каменев, С. В.  

К18 Компьютерное моделирование и обработка данных в прикладных на-
учных исследованиях: учебное пособие / С. В. Каменев, К. В. Марусич; 
Оренбургский гос. ун-т. – Оренбург: ОГУ, 2013. – 153 с. 
ISBN 

 
 

Учебное пособие представляет собой практическое руководство для 
выполнения лабораторного практикума по дисциплине «Основы научных 
исследований» студентами направлений подготовки 151900 Конструкторско-
технологическое обеспечение машиностроительных производств, 221000 
Мехатроника и робототехника, 160400 Ракетные комплексы и космонавтика.  

Так же может быть полезно при изучении ряда дисциплин, таких как 
«Обработка экспериментальных данных», «Современные системы инженер-
ного анализа станков», «Компьютерные технологии в науке и производст-
вах», «Компьютерные технологии в науке и производстве в ракетостроении» 
студентами указанных направлений и дисциплины «Компьютерные техноло-
гии в науке и производстве в авиа- и ракетостроении» студентами направле-
ния 160100 Авиастроение. 

В пособии рассмотрены особенности совместного использования  ав-
томатизированных компьютерных систем ANSYS и ORIGIN для решения 
инженерных задач, связанных с математическим моделированием и обра-
боткой экспериментальных данных в различных областях профессиональной 
деятельности.   

   
 
 
 

УДК 001.891:004(075.8) 
ББК 72.4я7+32.973-018я7  

 
 
 

ISBN                                                                                    © Каменев С. В.,  
                                                                                                               Марусич К. В., 2013 
                                                                                                           © ОГУ, 2013 
 



3 

Содержание 
 
Введение ............................................................................................................................... 5 
1 Лабораторная работа №1. Построение модели пружинного маятника ...................... 6 
1.1 Описание решаемой задачи.......................................................................................... 6 
1.2 Выбор типа анализа....................................................................................................... 7 
1.3 Выбор необходимых типов конечных элементов...................................................... 8 
1.4 Определение моделей материала............................................................................... 11 
1.5 Формирование модели цилиндра .............................................................................. 15 
1.6 Формирование модели пружины ............................................................................... 26 
1.7 Контрольные вопросы ................................................................................................ 36 
2 Лабораторная работа №2. Статический расчет пружинного маятника.................... 37 
2.1 Подготовка к расчету .................................................................................................. 37 
2.2 Выбор вида расчета ..................................................................................................... 37 
2.3 Приложение инерционной нагрузки ......................................................................... 38 
2.4 Наложение условий закрепления............................................................................... 39 
2.5 Запуск процедуры решения........................................................................................ 41 
2.6 Просмотр и анализ полученных результатов ........................................................... 42 
2.7 Определение закона изменения жесткости пружины ............................................. 49 
2.8 Контрольные вопросы ................................................................................................ 56 
3 Лабораторная работа №3. Динамический расчет пружинного маятника ................ 58 
3.1 Описание решаемой задачи........................................................................................ 58 
3.2 Определение условий закрепления модели .............................................................. 58 
3.3 Реализация первого шага решения ............................................................................ 60 
3.4 Реализация второго шага решения ............................................................................ 64 
3.5 Просмотр полученных результатов........................................................................... 65 
3.6 Расчет колебаний маятника при переменном коэффициенте демпфирования .... 71 
3.7 Контрольные вопросы ................................................................................................ 72 
4 Лабораторная работа №4. Гармонический анализ пружинного маятника............... 74 
4.1 Описание решаемой задачи........................................................................................ 74 
4.2 Выбора вида расчета и установок решения.............................................................. 74 
4.3 Наложение граничных условий и запуск расчета.................................................... 75 



4 

4.4 Обработка полученных результатов.......................................................................... 77 
4.5 Контрольные вопросы................................................................................................. 80 
5 Лабораторная работа №5. Визуализация результатов расчетов при помощи 
двухмерных диаграмм....................................................................................................... 81 
5.1 Использование автоматизированных систем обработки данных........................... 81 
5.2 Подготовка данных для построения двухмерного графика.................................... 81 
5.3 Отображение данных на графике .............................................................................. 87 
5.4 Редактирование полученного графика ...................................................................... 88 
5.5 Построение дополнительных графиков .................................................................. 100 
5.6 Контрольные вопросы............................................................................................... 104 
6 Лабораторная работа №6. Построение трехмерного графика поверхности .......... 105 
6.1 Подготовка данных для построения графика поверхности .................................. 105 
6.2 Отображение данных на графике ............................................................................ 111 
6.3 Редактирование полученного графика .................................................................... 111 
6.4 Контрольные вопросы............................................................................................... 119 
7 Лабораторная работа №7. Аппроксимация двухмерных экспериментальных  
данных............................................................................................................................... 120 
7.1 Подготовка исходных данных.................................................................................. 120 
7.2 Аппроксимация данных линейной функцией ........................................................ 120 
7.3 Визуализация результатов аппроксимации ............................................................ 123 
7.4 Аппроксимация данных периодической функцией ............................................... 127 
7.5 Аппроксимация данных пиковой функцией........................................................... 132 
7.6 Контрольные вопросы............................................................................................... 134 
8 Лабораторная работа №8. Аппроксимация трехмерных экспериментальных 
 данных ............................................................................................................................. 135 
8.1 Подготовка исходных данных.................................................................................. 135 
8.2 Выбор аппроксимирующей функции ...................................................................... 136 
8.3 Визуализация результатов аппроксимации ............................................................ 138 
8.4 Контрольные вопросы............................................................................................... 142 
Список использованных источников ............................................................................ 143 
Приложение А Исходные данные для выполнения лабораторных работ ................. 144 
Приложение Б Пример оформления отчета по лабораторным работам.................... 145 



5 

Введение 
 
Эффективное функционирование современного производства невозможно без 

систематического внедрения в него передовых достижений науки и техники. При 

этом элементы научного исследования все в большей мере входят в инженерную 

деятельность, т.к. разработка новых технологических процессов и проектирование 

машин и механизмов для их реализации требует постоянного поиска новых идей, 

проведения исследований работы механизмов и технологических машин, выбора 

оптимальных параметров и режимов процессов. 

Для успешного выполнения указанных видов деятельности современному ин-

женеру необходимо владеть различными методами научных исследований. Одним 

из наиболее распространенных методов исследования в инженерной практике явля-

ется компьютерное математическое моделирование, в большинстве случае, реали-

зуемое на основе автоматизированных систем инженерного анализа (CAE-систем).    

Современные САЕ-системы представляют собой мощные средства компью-

терного моделирования с развитым сервисным инструментарием, успешно приме-

няющиеся для решения многих практических задач. В настоящее время на рынке 

программного обеспечения представлено большое количество самых разнообразных 

систем подобного назначения. Одной из наиболее популярных систем является 

CAE-система «ANSYS» (разработчик ANSYS, Inc), особенности использования ко-

торой рассмотрены в данном пособии. 

В большинстве случаев данные, получаемые в результате компьютерного мо-

делирования, так же как и данные, получаемые в результате экспериментальных ис-

следований, нуждаются в дополнительной обработке. Для автоматизации этой обра-

ботки обычно применяются специализированные компьютерные системы анализа 

данных и технической графики, характеризующиеся большим выбором средств ана-

лиза и построения графиков, способностью работать с множеством типов данных 

большей размерности, а также повышенной производительностью за счет автомати-

зации рутинных задач. Примером такой системы является программный продукт 

Origin фирмы OriginLab, рассмотренный в настоящем пособии.  
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1 Лабораторная работа №1. Построение модели пружинного 

маятника 
 

Цель работы: ознакомление с классическим интерфейсом CAE-системы 

«ANSYS», изучение основных инструментов препроцессора системы и приобрете-

ние навыков построения конечно-элементных моделей с использованием препро-

цессора.  

 
1.1 Описание решаемой задачи 

 
В данной работе рассматриваются особенности математического моделирова-

ния в CAE-системе «ANSYS» на примере построения модели пружинного маятника. 

Пружинный маятником принято назвать колебательную механическую систему, со-

стоящую из пружины фиксированной жесткости, один конец которой жестко закре-

плен, а на втором конце находится тело определенной массы.  

Модель пружинного маятника, описываемая далее, представлена в виде мас-

сивного тела цилиндрической формы, подвешенного на спиральной цилиндриче-

ской пружине, не имеющей собственной массы. Расчетная схема, используемая для 

построения модели, приведена на рисунке 1.1. Построение модели выполняется по 

индивидуальным вариантам, отличающихся друг от друга набором исходных дан-

ных (приложение А).  

Исходными данными для построения модели являются: диаметр витка пружи-

ны d (в рассматриваемом примере равный 30 мм), диаметр сечения витка dw (равный 

2 мм), шаг пружины S (равный 5 мм), число витков N (составляющее 20 шт.) и масса 

цилиндра m (равная 2 кг). Дополнительно для пружины задаются параметры, опре-

деляющие физические свойства материала (модуль упругости и коэффициент Пуас-

сона). В данном случае материалом пружины служит конструкционная сталь с мо-

дулем упругости равным 210 ГПа и коэффициентом Пуассона равным 0,3. 
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Рисунок 1.1 – Расчетная схема пружинного маятника 
 

1.2 Выбор типа анализа 

 
Для выбора типа анализа, позволяющего проводить расчеты различных меха-

нических систем, необходимо выполнить следующую последовательность действий. 

После  запуска системы «ANSYS» перейдем к ее главному меню (ANSYS 

Main Menu), расположенному в левой части главного окна программы, и щелчком 

левой кнопки мыши запустим из него команду Preferences (соответствующий пункт 

выделен цветом на рисунке 1.2). 

 

 
 

Рисунок 1.2 – Главное меню «ANSYS» 
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В появившемся диалоговом окне Preferences for GUI Filtering установим фла-

жок Structural (рисунок 1.3) и нажмем кнопку Ok.  

 

 
 

Рисунок 1.3 – Фрагмент окна Preferences for GUI Filtering 
 

1.3 Выбор необходимых типов конечных элементов 

 
Выбор необходимых конечных элементов и формирование наборов их дейст-

вительных констант выполним в следующей последовательности.  

В главном меню «ANSYS» последовательно развернем пункты Preprocessor и 

Element Type, а затем запустим команду Add/Edit/Delete, при помощи которой осу-

ществляется доступ к библиотеке конечных элементов (рисунок 1.4). 

 

 
 

Рисунок 1.4 – Запуск процедуры выбора конечных элементов 
 

Запуск команды приведет к появлению окна Element Types (рисунок 1.5), в ко-

тором нужно просто нажать на кнопку Add. Это, в свою очередь, приведет к появле-

нию следующего окна Library of Element Types (рисунок 1.6), при помощи которого 

производится выбор необходимых типов элементов.      
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Рисунок 1.5 – Диалоговое окно Element Types 
 

Основными элементами текущего окна являются два списка: список категорий 

элементов (слева) и список видов элементов, входящих в каждую категорию (спра-

ва). Здесь в списке категорий сначала нужно выбрать категорию Beam, а затем в 

списке видов выбрать пункт tapered 44 (2 node 188 в версии ANSYS 13 и выше), по-

сле чего нажать кнопку Apply. Указанную процедуру далее требуется повторить еще 

два раза, но с выбором категории Solid и пункта Quad 4 node 42 в первом случае и 

пункта Brick 8 node 45 во втором случае (соответственно Quad 4 node 182 и Brick 

8 node 185 в версии ANSYS 13 и выше). В последнем случае выбор элемента под-

тверждается нажатием кнопки Ok, что сразу приведет к закрытию активного окна.  

 

 
 

Рисунок 1.6 – Окно библиотеки конечных элементов 
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После этого снова станет активным окно Element Types (рисунок 1.5), где в 

поле Define Element Types: появятся три строки с названиями, соответствующими 

выбранным типам элементов. Для продолжения работы нужно закрыть окно кноп-

кой Close. 

Один из выбранных типов элементов, а именно Type1 BEAM44 (BEAM188), 

требует создания для него либо набора действительных констант [4], либо опреде-

ления сечения, поскольку данный элемент является одномерным. При решении рас-

сматриваемой задачи более простым и удобным вариантом представляется исполь-

зование сечения.  

Для создания сечения в главном меню последовательно выбираются пункты 

Preprocessor, Sections и Beam, после чего запускается команда Common Sections (ри-

сунок 1.7). В результате откроется панель Beam Tool (рисунок 1.8), служащая для 

создания сечений, используемых в балочных и оболочечных конечных элементах.  

На этой панели необходимо войти в комбинированный список Sub-Type и вы-

брать нужную форму сечения (в данном случае это круг). После этого под изобра-

жением выбранного сечения появятся три текстовых поля R, N и T. Здесь в поле R 

требуется задать радиус сечения витка пружины в метрах. Для рассматриваемого 

примера – это 0,001 м. Нажатие кнопки OK приведет к тому, что в базу данных мо-

дели будет добавлено сечение под номером 1 (поле ID на рисунке 1.8), предназна-

ченное для элемента BEAM44 (BEAM188). 

 

 
 

Рисунок 1.7 – Вызов панели Beam Tool 
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Рисунок 1.8 – Панель Beam Tool 
 

1.4 Определение моделей материала 

 
Доступ к инструментам для работы с моделями материалов в CAE-системе 

«ANSYS» производится путем последовательного выбора в главном меню пунктов 

Preprocessor и Material Props и запуска команды Material Models (рисунок 1.9). За-

пуск указанной команды приводит к открытию окна Define Material Model Behavior, 

приведенного на рисунке 1.10. В этом окне в поле Material Models Defined, располо-

женном слева, можно видеть заданную по умолчанию модель материала Material 

Model Number 1. В поле Material Models Available (справа) приведены наименования 

физических свойств, доступных для текущей модели материала [5].    
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Рисунок 1.9 – Вызов окна Define Material Model Behavior 
 

 
 

Рисунок 1.10 – Окно Define Material Model Behavior 
 

В этом поле нужно двойным щелчком левой кнопки мыши (простым щелчком 

в версии ANSYS 13 и выше) последовательно развернуть пункты Structural, Linear и 

Elastic, а затем один раз щелкнуть по пункту Isotropic, что вызовет появление окна, 

приведенного на рисунке 1.11. Здесь в текстовом поле EX необходимо задать значе-

ние модуля упругости для данного случая равное 2,1е11 Па (единицы измерения не 

указываются), а в поле – значение коэффициента Пуассона равное 0,3, что соответ-

ствует конструкционной стали. После нажатия кнопки OK в текущую модель мате-
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риала будут добавлены два параметра, определяющие упругие свойства материала 

пружины. 

 
 

Рисунок 1.11 – Диалоговое окно Linear Isotropic Properties… 

 
Кроме этих двух параметров в модель так же необходимо включить коэффи-

циент демпфирования, характеризующий демпфирующие свойства материала. Ввод 

коэффициента демпфирования производится при помощи окна (параметр DAMP), 

приведенного на рисунке 1.12. Для вызова этого окна в поле Material Models Avail-

able (рисунок 1.10) нужно последовательно активировать пункты Structural, Damping 

и Constant. В данном случае примем значение коэффициента демпфирования рав-

ным 0,0075 и нажмем кнопку OK. 

 

 
 

Рисунок 1.12 – Диалоговое окно Damping… 



14 

Для моделирования цилиндра полученную модель материала использовать 

нельзя, поскольку цилиндр должен обладать массой и, соответственно, модель ма-

териала для него должна включать в себя значение объемной плотности. Это значе-

ние необходимо предварительно рассчитать как отношение заданной массы к объе-

му цилиндра. Так как размеры цилиндра не заданы,  можно принять высоту и диа-

метр цилиндра равными 2,5d. Тогда объем цилиндра приближенно определится как 

12,272d3, что для данного случая составит 0,000331 м3. Соответственно плотность 

необходимая для обеспечения заданной массы (2 кг) будет равняться 6042 кг/м3.  

Добавление новой модели материала производится путем входа в пункт Mate-

rial меню, присутствующего в окне Define Material Model Behavior (рисунок 1.10) и 

запуска оттуда команды New Model. После чего в поле Material Models Defined поя-

вится еще одна строка с названием Material Model Number 2. Выделив эту строку 

сначала нужно рассмотренным выше способом назначить добавленной модели ма-

териала модуль упругости и коэффициент Пуассона, а затем ввести расчетное зна-

чение объемной плотности. Для этого требуется последовательно активировать в 

поле Material Models Available пункты Structural и Density, в результате чего появит-

ся окно Density for Material Number 2 (рисунок 1.13). В строку DENS этого окна вве-

дем необходимое значение плотности материала и нажмем кнопку OK. 

 

 
 

Рисунок 1.13 – Диалоговое окно Density… 
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После того как обе модели материала будут полностью определены, нужно за-

крыть окно  Define Material Model Behavior (рисунок 1.10) с использованием кнопки 

«Закрыть» в заголовке окна либо команды Exit в пункте меню Material.  

 
1.5 Формирование модели цилиндра 

 
Формирование геометрической модели цилиндра в силу его правильной фор-

мы удобно совместить с построением его сеточной модели. Для этого необходимо 

выполнить ряд операций. Первой из них является построение прямоугольника, оп-

ределяющего половину осевого сечения цилиндра. Запуск соответствующей коман-

ды осуществляется путем последовательной активации в главном меню ANSYS 

пунктов Preprocessor → Modeling → Create → Areas → Rectangle → By 2 Corners 

(рисунок 1.14). Это приведет к появлению окна, изображенного на рисунке 1.15. 

 

 
 

Рисунок 1.14 – Запуск команды By 2 Corners 
 

Здесь в полях WP X и WP Y зададим координаты, определяющие привязку 

прямоугольника к текущей системе координат (нуль в обоих случаях). В полях 

Width и Height соответственно зададим ширину и высоту прямоугольника в метрах. 

При этом здесь возможен ввод числовых значений не только в явной форме, но и в 

виде математических выражений. Например, для рассматриваемого примера в поле 

Width можно ввести выражение 2.5*0.03/2, а в поле – выражение –2.5*0.03 (знак «–» 

означает, что высота прямоугольника будет отсчитываться вниз от исходной точки).   
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Рисунок 1.15 – Диалоговое окно Rectangle by 2 Corners 
 

В случае правильного ввода необходимых значений после нажатия кнопки OK 

на экране появится прямоугольник, который должен выглядеть так, как показано на 

рисунке 1.16.  

 
 

Рисунок 1.16 – Результат построения сечения цилиндра 
 
 



17 

Полученный прямоугольник подвергнем ряду преобразований, необходимых 

для нанесения на него упорядоченной сетки плоских конечных элементов. Для этого 

сначала путем последовательного выбора пунктов главного меню Preprocessor → 

Modeling → Move/Modify → Reverse Normals → of Lines вызовем панель интерак-

тивного выбора объектов. В данном случае эта панель будет иметь название Reverse 

Line Normals (рисунок 1.17).  

После появления панели щелчком левой кнопки мыши выберем верхнюю го-

ризонтальную линию (границу) прямоугольника (рисунок 1.16) и нажмем кнопку 

OK на панели выбора. В окне появившемся вслед за этим сразу нажмем кнопку OK 

и завершим выполнение текущей команды. В результате выполнения данной коман-

ды ориентация нормали выбранной линии (справа налево) будет изменена на проти-

воположную (слева направо), что необходимо для дальнейших построений. 

 

 
 

Рисунок 1.17 – Панель управления интерактивным выбором объектов 
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Далее последовательно активируем в главном меню ANSYS пункты Preproces-

sor → Modeling → Operate → Booleans → Divide. Среди команд сгруппированных в 

пункте Divide выберем команду Lines w/Options (рисунок 1.18).  

 

 
 

Рисунок 1.18 – Запуск команды «Lines w/Options» 
 

В результате снова появится панель выбора объектов (уже с другим названи-

ем), при помощи которой теперь нужно выбрать обе горизонтальные линии прямо-

угольника (верхнюю и нижнюю границы) и нажать кнопку OK. Это вызовет диало-

говое окно Divide Multiple Lines with Options, приведенное на рисунке 1.19.  

 

 
 

Рисунок 1.19 – Диалоговое окно Divide Multiple Lines with Options 
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Здесь в текстовом поле RATIO введем коэффициент равный 0,4 и нажмем 

кнопку OK. После этого каждая из выбранных линий будет разделена на две части, 

относящихся друг к другу по длине как 2/3.  

Чтобы убедиться в правильности результата выполненной операции переклю-

чимся на режим отображения линий. Для этого используем меню утилит ANSYS 

(рисунок 1.20) и войдем в его пункт Plot, а затем запустим оттуда команду Lines.  

 

 
 

Рисунок 1.20 – Меню утилит ANSYS 
 

Кроме того, для удобства дальнейших построений включим нумерацию ли-

ний, что реализуется путем входа в пункт PlotCtrls меню утилит и запуска команды 

Numbering. Запуск данной команды вызовет диалоговое окно Plot Numbering Con-

trols (рисунок 1.21). 

 

 
 

Рисунок 1.21 – Диалоговое окно Plot Numbering Controls 
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 В этом окне нужно установить флажок LINE в положение On и нажать кнопку 

OK. В результате выполненных действий изображение на экране должно принять 

вид, показанный на рисунке 1.22.  

 
 

Рисунок 1.22 – Сечение цилиндра в режиме отображения линий 

 

Далее линии, образующие контур прямоугольника нужно разметить для по-

следующего нанесения сетки. Для этого воспользуемся командой Picked Lines дос-

тупной в главном меню путем последовательной активации пунктов Preprocessor → 

Meshing → Size Cntrls → ManualSize → Lines → Picked Lines (рисунок 1.23). 

 

 
 

Рисунок 1.23 – Запуск команды Picked Lines 
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Запуск команды приведет к появлению панели выбора объектов, при помощи 

которой сначала нужно выбрать короткие горизонтальные линии контура (линии L5 

и L8 на рисунке 1.22) и нажать кнопку OK. В результате откроется диалоговое окно 

Element Sizes on Picked Lines, представленное на рисунке 1.24.   

 

 
 

Рисунок 1.24 – Диалоговое окно Element Sizes on Picked Lines 

 

В поле NDIV этого окна зададим число делений выбранных линий равное 2 и 

нажмем кнопку Apply. При помощи вновь появившейся панели выбора объектов 

выберем теперь длинные горизонтальные линии контура (L6 и L7 на рисунке 1.22), а 

затем в окне Element Sizes on Picked Lines зададим для них число делений равное 3. 

Далее аналогичным способом разделим вертикальные линии контура (L2 и L4) на 6 

частей, завершив выполнение текущей команды кнопкой OK. После этого контур 

сечения должен принять вид, показанный на рисунке 1.25.  
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Рисунок 1.25 – Контур сечения после разметки линий 

 

Перед непосредственным нанесением сетки выполним еще одну операцию, 

для чего последовательно активируем в главном меню ANSYS пункты Preprocessor 

→ Meshing → Concatenate → Lines, а затем при помощи панели выбора объектов 

выберем две верхние горизонтальные линии контура (L8 и L7 на рисунке 1.25) и 

нажмем кнопку OK. Эту же процедуру повторим и для нижней пары горизонталь-

ных линий (L5 и L6). 

Далее необходимо выбрать тип элемента для нанесения сетки и модель мате-

риала. Этот выбор может быть реализован при помощи диалогового окна Meshing 

Attributes (рисунок 1.26), вызываемого путем последовательного выбора в главном 

меню следующих пунктов Preprocessor → Meshing → Mesh Attributes → Default At-

tribs. 

В этом окне сначала войдем в комбинированный список [TYPE] Element type 

number и выберем в нем пункт 2 PLANE42 (PLANE182). Затем перейдем к соседне-

му списку [MAT] Material number и выберем в нем пункт 2, что соответствует моде-

ли материала, предназначенной для моделирования цилиндра. Сделав необходимый 

выбор, нажмем кнопку OK.  
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Рисунок 1.26 – Диалоговое окно Meshing Attributes 
 

Для запуска процедуры построения сетки плоских элементов последовательно 

активируем в главном меню пункты Preprocessor → Meshing → Mesh → Areas → 

Mapped → 3 or 4 sided и перейдем в режим выбора объектов. Находясь в этом режи-

ме, щелкнем левой кнопкой мыши по контуру сечения и нажмем кнопку OK. Для 

просмотра полученного результата переключимся на режим отображения элемен-

тов, для чего в меню утилит (рисунок 1.20) войдем в пункт Plot и запустим оттуда 

команду Elements. В случае правильности выполнения рассмотренных операций, ре-

зультат построения сетки должен выглядеть так, как показано на рисунке 1.27. 
 

 
 

Рисунок 1.27 – Результат построения сетки на сечении цилиндра 
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Далее полученное сечение и сетку плоских элементов на нем требуется преоб-

разовать собственно в цилиндр с сеткой объемных элементов. Для этого, прежде 

всего, нужно подготовить геометрию сечения к этому преобразованию, для чего по-

следовательно активировать в главном меню последовательность пунктов  

Preprocessor → Meshing → Concatenate → Del Concats → Lines. Затем нужно задать 

настройки преобразования. Доступ к этим настройкам осуществляется в окне 

Element Extrusion Options (рисунок 1.28), вызываемого путем выбора в главном ме-

ню пунктов Preprocessor → Modeling → Operate →  Extrude → Elem Ext Opts. 

 

 
 

Рисунок 1.28 – Диалоговое окно Element Extrusion Options 
 

Здесь, во-первых, нужно войти в комбинированный список [TYPE] Element 

type number и выбрать в нем пункт 3 SOLID45 (SOLID185). Во-вторых, войти в спи-

сок [MAT] Material number и выбрать в нем пункт From Areas. В-третьих, в группе 

Element sizing options for extrusion ввести в поле VAL1 требуемое число элементов 
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по дуге окружности (зададим 10). В завершении нужно установить флажок ACLEAR 

Clear area(s) after ext в положение Yes и нажать кнопку OK. 

После этого снова перейдем к главному меню и задействуем следующую по-

следовательность его пунктов Preprocessor → Modeling → Operate →  Extrude → Ar-

eas → About Axis. В результате появится панель выбора объектов, при помощи ко-

торой нужно выбрать поверхность, путем вращения которой должен быть образован 

цилиндр. Здесь просто щелкнем левой кнопкой мыши по прямоугольнику сечения и 

нажмем кнопку OK. 

Далее еще раз появится панель выбора, но теперь предназначенная для выбора 

двух точек определяющих ось вращения цилиндра. В качестве таких точек выберем 

точки, соответствующие левому верхнему и левому нижнему углу прямоугольника 

и опять нажмем кнопку OK. В появившемся после этого окне (рисунок 1.29) необ-

ходимо задать угол дуги и число сегментов будущего цилиндра. Угол дуги (поле 

ARC) оставим равным 360°, а число сегментов зададим равным двум. 

 

 
 

Рисунок 1.29 – Диалоговое окно Sweep Areas about Axis 
 

При нажатии кнопки OK будет сформирован цилиндр, состоящий из двух по-

ловин с автоматически нанесенной на них регулярной сеткой призматических ко-

нечных элементов (рисунок 1.30). Для просмотра построенной сеточной модели 

нужно снова переключиться в режим отображения элементов путем запуска коман-

ды Elements из пункта Plot меню утилит. Для изменения ориентации изображения 

модели на экране можно использовать кнопки управления видами, набор которых 

расположен справа от графической зоны ANSYS. 
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Рисунок 1.30 – Сеточная модель цилиндра 
 

1.6 Формирование модели пружины 

 
К полученной модели цилиндра далее необходимо присоединить модель пру-

жины. На данном этапе, прежде всего, нужно деактивировать все линии, принадле-

жащие цилиндру и отключить нумерацию линий, включенную ранее. Для деактива-

ции линий требуется войти в пункт Select меню утилит и запустить оттуда команду 

Entities, в результате чего на экране появится панель Select Entities (рисунок 1.31). 

 

 
 

Рисунок 1.31 – Панель Select Entities 
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На этой панели войдем в ее самый верхний комбинированный список и выбе-

рем в нем пункт Lines, а затем нажмем кнопку Sele None. После этого панель можно 

закрыть нажатием кнопку Cancel. 

Отключение нумерации линий осуществляется простым снятием флажка 

LINES в окне на рисунке 1.21. 

Чтобы сформировать геометрию пружины необходимо заменить активную 

прямоугольную систему координат цилиндрической системой координат с полярной 

осью Y [1]. Для этого в меню утилит нужно последовательно выбрать следующие 

его пункты WorkPlane → Change Active CS to → Global Cylindrical Y. 

Далее переключимся на режим отображения поверхностей, для чего в меню 

утилит последовательно выберем пункты Plot → Areas. После этого в главном меню 

последовательно выберем пункты Preprocessor → Modeling → Copy → Keypoints, 

что приведет к активации панели выбора объектов. При помощи этой панели ука-

жем на модели точку, обозначенную на рисунке 1.32, а затем нажмем кнопку OK. 
 

 
 

Рисунок 1.32 – Модель цилиндра в режиме отображения поверхностей 
 

После выбора точки откроется окно Copy Keypoints, приведенное на рисунке 

1.33. В этом окне в поле ITIME оставляем значение по умолчанию равное 2, в поле 

DX вводим величину смещения по радиусу равную 0, в поле DY вводим величину 

углового смещения, которую примем равной 12°.  
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Рисунок 1.33 – Диалоговое окно Copy Keypoints 
 

В поле DZ необходимо ввести величину смещения по оси цилиндра. Зададим 

ее в виде выражения 0.005*12/360, где 0,005 – заданный осевой шаг пружины в мет-

рах, 12 – величина углового смещения, заданная в поле DY, 360 – угол, соответст-

вующий одному полному витку пружины. 

При нажатии кнопки OK будет построена копия выбранной точки, смещенная 

от исходного положения с использованием цилиндрической системы координат. 

При этом изображение модели на экране будет автоматически переключено в режим 

отображения точек. В случае необходимости можно переключиться на этот режим 

принудительно путем выбора в меню утилит пунктов Plot → Keypoints. 

Полученное изображение увеличим (при помощи кнопок управления видами) 

таким образом, чтобы копия точки и ее оригинал четко просматривались на экране. 

Теперь эти точки нужно соединить отрезком прямой линии. Для этого в главном 

меню ANSYS активируем последовательность пунктов Preprocessor → Modeling → 

Create → Lines → Lines → Straight Line. Затем при помощи панели выбора объектов 

укажем на экране необходимые точки и нажмем кнопку OK.  

Далее переключимся в режим отображения линий (Plot → Lines) и приступим 

к операции копирования полученной линии. Для реализации этой операции в глав-
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ном меню активируем пункты Preprocessor → Modeling → Copy → Lines, а затем 

выберем линию (кнопка OK на панели выбора), подлежащую копированию. 

В результате этого появится окно, аналогичное окну на рисунке 1.33, но с на-

званием Copy Lines. Здесь в поле ITIME запишем выражение 30*20, где 30 – число 

копий линии, образующих один виток пружины, 20 –  число витков. В полях DX, 

DY и DZ зададим значения такие же, как и в предыдущем случае (рисунок 1.33). 

После нажатия кнопки OK должна быть сформирована геометрическая модель пру-

жины, витки которой аппроксимированы отрезками прямых линий (рисунок 1.34). 

Для просмотра полученного результата удобно использовать кнопку управления ви-

дами Fit View .   

 
 

Рисунок 1.34 – Геометрическая модель пружины 
 

На следующем этапе к верхней части построенной пружины нужно присоеди-

нить еще один виток, все точки которого не имеют винтового подъема, т.е. находят-

ся в одной плоскости. Перед этим требуется выполнить несколько вспомогательных 

операций. Первой из них является деактивация всех линейных сегментов пружины 

кроме самого верхнего из них. Для этого нужно при помощи меню утилит снова вы-

звать панель Select Entities (рисунок 1.31), выбрать в ее верхнем комбинированном 

списке пункт Lines и нажать кнопку Apply.  

Это приведет к появлению уже знакомой панели управления интерактивным 

выбором Select Lines, при помощи которой нужно выбрать необходимую линию. По 

умолчанию эта линия будет иметь максимальный порядковый номер, автоматически 
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отображаемый на активной панели в строке Maximum (рисунок 1.35). В данном слу-

чае этот номер равен 619. Для активации линии с этим номером (и соответственно 

деактивации всех остальных) достаточно просто ввести этот номер в текстовое поле 

ниже (рисунок 1.35), нажать клавишу Enter для подтверждения выбора и завершить 

команду кнопкой OK. 

 

 
 

Рисунок 1.35 – Фрагмент панели Select Lines 
 

Чтобы удостовериться в правильности выполненной операции из пункта Plot 

меню утилит запустим команду Replot, а затем нажмем кнопку управления видами 

Fit View. В результате на экране должна отобразиться единственная линия, вписан-

ная в графическую зону ANSYS. 

Теперь из всего множества точек модели нужно сделать активными лишь те 

две точки, которые принадлежат выбранной линии. Для этого снова воспользуемся 

панелью Select Entities, где в верхнем комбинированном списке выберем пункт Key-

points. В списке ниже выберем пункт Attached to и включим переключатель Lines 

(рисунок 1.36), после чего нажмем кнопку Apply. Завершив выполнение команды, 

переключимся на режим отображения точек (Plot → Keypoints → Keypoints) и на-

жмем кнопку управления видами Top View . При этом на экране должны отобра-

зиться всего две точки, соответствующие концам линии. 
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Рисунок 1.36 – Выбор точек, принадлежащих активной линии 
 

К точке, расположенной на верхнем конце линии, применим процедуру копи-

рования, для чего в главном меню ANSYS задействуем пункты Preprocessor → Mod-

eling → Copy → Keypoints. В результате снова появится окно, изображенное на ри-

сунке 1.33. На этот раз здесь принимаем число копий (ITIME) равное 2, в полях DX 

и DZ указываем нули, в поле DY задаем угловое смещение равное 12°. После нажа-

тия кнопки OK на экране должна появиться третья точка, смещенная вверх от ис-

ходной точки. 

Полученную копию точки нужно соединить линией с исходной точкой (верх-

нюю точку соединить со средней точкой), для чего используется соответствующая 

команда, вызываемая выбором последовательности пунктов главного меню Preproc-

essor → Create → Lines → Lines → Straight Line.  

Далее требуется размножить построенную линию при помощи операции ко-

пирования. Перед этим желательно переключиться в режим отображения линий 

(Plot → Lines). Копирование линии осуществляется путем активации последова-

тельности пунктов Preprocessor → Modeling → Copy → Lines, выбора необходимой 

линии и ввода данных в окне, аналогичном приведенному на рисунке 1.33. В этом 
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окне зададим число копий (ITIME) равное 30, радиальное и осевое смещение (DX и 

DZ) примем равными нулю, а угловое смещение (DY) зададим равным 12°. После 

ввода необходимых данных нажмем кнопку OK. Результат построения должен вы-

глядеть в виде кольца, состоящего из 30 линейных участков. 

На следующем этапе необходимо объединить все линейные участки пружины 

путем создания общих точек. Для этого сначала требуется активировать все неак-

тивные линии, отключенные ранее. Активацию линий выполним с использованием 

панели Select Entities (рисунок 1.31). В данном случае здесь нужно выбрать пункт 

Lines в верхнем комбинированном списке, а затем нажать кнопку Sele All.  

После этого необходимо отделить линии, принадлежащие модели пружины, 

от линий, принадлежащих модели цилиндра. Выполним эту операцию при помощи 

все той же панели Select Entities в следующем порядке. Сначала в верхнем комбини-

рованном списке панели выберем пункт Keypoints (рисунок 1.37).  

 

 
 

Рисунок 1.37 – Выбор точек по координате 
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Далее включим переключатель Z coordinates, в поле Min,Max введем выраже-

ние минус 2.5*0.03 (где 0,03 – заданный диаметр пружины в метрах), после чего 

ниже включим переключатель Unselect и нажмем кнопку Apply. 

В завершении выберем в верхнем списке пункт Lines, в соседнем списке – 

пункт Attached to, включим переключатели Keypoints, all и From Full, а затем на-

жмем кнопку OK (рисунок 1.38). После регенерации изображения (Plot → Replot) на 

экране должны отобразиться лишь линии, принадлежащие модели пружины. 

 

 
 

Рисунок 1.38 – Выбор линий, соединяющих активные точки 

 

Выделенные линии объединим между собой при помощи операции «склеива-

ния», запуск которой производится путем выбора в главном меню пунктов Preproc-

essor → Modeling → Operate → Booleans → Glue → Lines. После запуска этой ко-

манды появится панель интерактивного выбора объектов, где требуется нажать 

кнопку Pick All, что приведет к непосредственной реализации активной команды. 
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Завершив объединение линий, приступим к формированию сеточной модели, 

для чего сначала выполним калибровку сетки, т.е. разметку выбранных линий. Для 

калибровки активируем последовательность пунктов Preprocessor → Meshing → Size 

Cntrls → ManualSize → All Lines. В поле NDIV появившегося вслед за этим окна 

(рисунок 1.24) введем число делений равное единице и закроем это окно кнопкой 

OK.  

Далее задействуем в главном меню последовательность пунктов Preprocessor 

→ Meshing → Mesh → Lines и нажмем кнопку Pick All на появившейся панели вы-

бора объектов. В результате на выбранных линиях будет сформирована сетка ко-

нечных элементов соответствующего типа. При этом изображение модели на экране 

автоматически переключится в режим отображения элементов. 

Для визуальной оценки корректности полученного результата дополнительно 

включим режим отображения формы элементов. Данный режим позволяет просмат-

ривать элементы в соответствии с назначенной им формой сечения. Включение это-

го режима производится при помощи меню утилит путем выбора следующих его 

пунктов PlotCtrls → Style → Size and Shape, что вызовет появление одноименного 

диалогового окна. 

В этом окне установим флажок [/ESHAPE] Display of element в положение On 

(рисунок 1.39) и нажмем кнопку OK. После этого изображение модели должно из-

мениться и принять вид подобный виду, представленному на рисунке 1.40. 

 

 
 

Рисунок 1.39 – Фрагмент диалогового окна Size and Shape 
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Рисунок 1.40 – Окончательный вид сеточной модели маятника 
 

В завершении работы переключимся обратно на прямоугольную систему ко-

ординат и активируем все неактивные объекты модели. Для переключения системы 

координат в меню утилит последовательно выберем пункты WorkPlane → Change 

Active CS to → Global Cartesian, а для активации объектов выберем пункты Select → 

Everything.  

Полученную модель сохраним в файл, для чего войдем в пункт File меню ути-

лит и запустим из него команду Save As. В результате появится диалоговое окно 

Save DataBase, приведенное на рисунке 1.41.  

В этом окне при помощи двойных щелчков в поле Directories: выберем необ-

ходимую для сохранения модели директорию, а затем зададим имя файла. Имя фай-

ла задается в поле Save Database to вместо звездочки (*) перед расширением (.db) 

файла. При этом имя файла должно состоять только из латинских букв и/или цифр. 

Использование кириллических символов в именах файлов ANSYS не допускается. 

Нужно добавить, что название директории, куда сохраняется файл так же не должно 

содержать кириллических символов. После выбора необходимой директории и вво-
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да имени файла нажмем кнопку OK и сохраним модель для проведения последую-

щих расчетов. 

 
 

Рисунок 1.41 – Диалоговое окно Save DataBase 

 
1.7 Контрольные вопросы 

 
1 Для чего предназначено главное меню ANSYS? 

2 Для чего предназначено меню утилит ANSYS? 

3 Как производится выбор конечных элементов для построения модели?  

4 Какие обязательные параметры должна включать в себя модель материала 

при решении задач механики твердого тела? 

5 Для чего задаются сечения при использовании балочных конечных элемен-

тов? 

6 Для чего производится разметка линий перед нанесением сетки? 

7 Для чего предназначена, присутствующая в главном меню, группа команд 

Modeling? 

8 Для чего предназначена, присутствующая в главном меню, группа команд 

Meshing? 

9 Какие операции могут быть выполнены при помощи команды из группы Op-

erate, присутствующей в главном меню?   

10 Какие операции выполняются при помощи панели Select Entities? 

11 Каким образом осуществляется переключение режимов отображения модели? 

12 Как производится выбор активной системы координат? 
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2 Лабораторная работа №2. Статический расчет пружинного 

маятника 
 

Цель работы: ознакомление с общими средствами CAE-системы «ANSYS», 

предназначенными для организации процедуры решения, приобретение навыков на-

ложения граничных условий и изучение особенностей проведения стационарных 

расчетов в рассматриваемой системе, изучение основных инструментов постпроцес-

сора системы для обработки результатов стационарных расчетов. 

 

2.1 Подготовка к расчету 

 

Расчет модели маятника начнем с определения жесткости пружины, которая 

является неизвестной величиной, зависящей от геометрических размеров пружины и 

физических свойств ее материала.  

Для определения жесткости, в данном случае, достаточно определить величи-

ну удлинения пружины под действием силы тяжести, действующей на груз, прикре-

пленный к свободному концу пружины. При этом к модели цилиндра необходимо 

приложить инерционную нагрузку, а на модели пружины задать соответствующие 

условия закрепления, определяющие положение модели в пространстве.  

Чтобы начать расчет необходимо сначала загрузить модель, сохраненную при 

выполнении предыдущей работы. Для загрузки модели из пункта File меню утилит 

запустим команду Resume From, после чего при помощи окна, аналогичного окну на 

рисунке 1.41, выберем нужный файл и нажмем кнопку OK. 

 

2.2 Выбор вида расчета 

 

Все операции, связанные с процедурой решения, осуществляются при помощи 

команд, сгруппированных в пункте Solution главного меню ANSYS. К ним относят-

ся команды, отвечающие за выбор вида расчета, настройки решения, наложение 

граничных и начальных условий, запуск процедуры решения и т.п. [2] 
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Открыв пункт Solution, далее последовательно выберем пункты Analysis Type 

и New Analysis, тем самым, вызывая окно, приведенное на рисунке 2.1. Данное окно 

предназначено для просмотра и выбора видов расчета, доступных для текущего типа 

анализа. Здесь включим переключатель Static и нажмем кнопку OK. 

 

 
 

Рисунок 2.1 – Диалоговое окно New Analysis 
 

2.3 Приложение инерционной нагрузки  

 
Для приложения инерционной нагрузки к модели цилиндра в главном меню 

последовательно выберем пункты Solution → Define Loads → Apply → Structural → 

Inertia → Gravity → Global и вызовем окно, приведенное на рисунке 2.2.  

 

 
 

Рисунок 2.2 – Диалоговое окно Apply (Gravitational) Acceleration 
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В поле ACEL Y Global Cartesian Y-comp приведенного окна введем величину 

ускорения свободного падения равную 9.81 м/с2. В двух остальных полях оставляем 

заданные по умолчанию нули. После нажатия кнопки OK для модели будет опреде-

лено ускорение, которое будет использоваться для расчета силы тяжести, дейст-

вующей на цилиндр. 

 

2.4 Наложение условий закрепления 

 
Для того чтобы обеспечить фиксацию верхнего конца пружины необходимо 

наложить на соответствующие узлы модели нулевые степени подвижности. Перед 

выполнением этой операции сначала задействуем в главном меню последователь-

ность пунктов Preprocessor → Modeling → Check Geom → Set Small Lines. В поя-

вившемся после этого окне (рисунок 2.3) введем в поле SIZE Select by Size выраже-

ние вида 0.03*sin(6) (где 0,03 – диаметр пружины в метрах, 6 – половина угла секто-

ра, хордой которого является каждая линия, составляющая верхний виток пружи-

ны). Задав необходимое выражение, закроем окно кнопкой OK. 

 

 
 

Рисунок 2.3 – Диалоговое окно Select Small Lines 
 

Далее вызовем панель Select Entities (Select → Entities). В верхнем комбиниро-

ванном списке этой панели выберем пункт Nodes, в соседнем списке – пункт At-

tached to. Затем включим переключатель Lines, all и нажмем кнопку OK. После пе-
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реключения на режим отображения узлов Plot → Nodes, на экране должны отобра-

зиться лишь узлы соответствующие верхнему витку пружины.   

На эти узлы теперь нужно наложить условия закрепления. Для этого в главном 

меню выберем пункты Solution → Define Loads → Apply → Structural → Displace-

ment → On Nodes. На появившейся вслед за этим панели интерактивного выбора 

сразу нажмем кнопку Pick All, в результате чего откроется окно, представленное на 

рисунке 2.4.  

В этом окне перейдем к списку Lab2 DOFs to be constrained и щелчком левой 

кнопки мыши выберем в нем шесть пунктов (UX, UY, UZ, ROTX, ROTY, ROTZ), 

соответствующих трем линейным и трем угловым степеням свободы. Затем введем 

в поле VALUE значение равное нулю и нажмем кнопку OK.  

 

 
 

Рисунок 2.4 – Окно выбора степеней свободы, накладываемых на узлы 
 

Наложив на модель необходимые нагрузки, снова активируем все неактивные 

объекты модели, для чего запустим команду Everything из пункта Select в меню ути-

лит. В результате выполненных операций при переключении в режим отображения 

элементов (Plot → Elements) модель должна выглядеть так, как показано на рисунке 

2.5. 
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Рисунок 2.5 – Сеточная модель с наложенными нагрузками 
 

2.5 Запуск процедуры решения 

 
В общем случае перед запуском процедуры решения требуется сконфигуриро-

вать настройки выбранного вида расчета. Но в данном случае заданные по умолча-

нию настройки изменять не нужно, и поэтому можно сразу перейти к непосредст-

венному запуску решения.  

Для запуска решения в главном меню ANSYS необходимо выбрать пункты So-

lution → Solve → Current LS. Запуск указанной команды приведет к появлению на 

экране двух окон /STATUS Command и Solve Current Load Step (рисунок 2.6). Окно 

/STATUS… служит для просмотра текущего статуса процедуры решения и его мож-

но сразу закрыть соответствующей кнопкой в заголовке окна. Окно Solve Current 

Load Step служит собственно для запуска решения, что осуществляется нажатием 

кнопки OK. 
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Рисунок 2.6 – Окно Solve Current Load Step 
 

После нажатия на эту кнопку должно появиться окно сообщения с надписью 

Solution is done!, информирующее о том, что расчет успешно завершен. Закрыв это 

кнопкой Close, приступим к просмотру полученных результатов.   

  
2.6 Просмотр и анализ полученных результатов 

 
Для просмотра результатов расчетов, не связанных с изменениями во времени, 

предназначена группа команд General Postproc в главном меню ANSYS. При этом 

просмотр результатов возможен как в числовой форме, так и различных формах 

графического представления.  

Наиболее наглядной формой представления полученных результатов для дан-

ной модели будет контурный график, совмещенный с геометрией модели. Чтобы 

построить такой график, в главном меню последовательно активируем пункты Gen-

eral Postproc → Plot Results → Contour Plot → Nodal Solu. В результате на экране 

появится диалоговое окно Contour Nodal Solution Data, показанное на рисунке 2.7. 

В этом окне перейдем к списку Item to be contoured, где в развернутом по 

умолчанию пункте Nodal Solution развернем пункт DOF Solution и выделим его под-

пункт Y-Component of displacement. После этого нажмем кнопку OK и построим не-

обходимый контурный график.  
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Рисунок 2.7 – Диалоговое окно Contour Nodal Solution Data 
 

Полученный график будет иметь вид, подобный изображению, представлен-

ному на рисунке 2.8. Для приведения графика в полное соответствие с рисунком 2.8 

необходимо выполнить ряд следующих мероприятий.  

Прежде всего, требуется изменить цвет фона рабочей зоны (с черного на бе-

лый). Это можно сделать путем выбора в меню утилит пунктов PlotCtrls → Style → 

Colors → Reverse Video.  

Легенду графика (цветовая шкала с числовыми значениями), по умолчанию рас-

положенную горизонтально, в данном случае целесообразно расположить вертикально. 

Проще всего это сделать при помощи контекстного меню, вызываемого щелчком пра-

вой кнопки мыши на поле легенды. В этом меню (рисунок 2.9) выберем пункт Contour 

Right, а затем регенерируем изображение командой Replot (Plot → Replot). 
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Рисунок 2.8 – Контурный график перемещений вдоль оси маятника 
 

 
 

Рисунок 2.9 – Контекстное меню легенды 
 

Кроме расположения легенды также желательно изменить ее шрифт,  показы-

вающий числовые значения. Это можно сделать при помощи того же контекстного 

меню путем запуска из него команды Legend Font. В результате запуска указанной 

команды появится типовое для Windows-приложений окно настройки шрифтов, при 

помощи которого выберем: шрифт – Arial, начертание – жирный и размер шрифта 

равный от 14 до 16 пт. Для визуализации сделанных изменений снова регенерируем 

изображение командой Replot.   
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Чтобы удалить изображение значка системы координат, а также лишние над-

писи в верхнем левом углу графической зоны в меню утилит последовательно выбе-

рем пункты PlotCtrls → Window Controls → Window Options, в результате чего от-

кроется диалоговое окно, приведенное на рисунке 2.10. Так же это окно можно вы-

звать при помощи контекстного меню, вызываемого щелчком правой кнопкой мыши 

на свободном месте графической зоны, и выбора в нем пунктов Graphics Properties 

→ Graphics Options. 

 

 
 

Рисунок 2.10 – Диалоговое окно Window Options 
 

В этом окне снимем флажки LEG1, LEG2, TITLE и FILE, в списке LOGO вы-

берем пункт Text in legend, в списке DATE – пункт No Date or Time и в списке 

[/TRIAD] – пункт Not shown. После этого закроем окно кнопкой OK. 



46 

В завершении отключим отображение формы сечения для балочных элемен-

тов в модели пружины. Для этого снимем флажок [/ESHAPE] в окне на рисунке 

1.39, вызываемом из меню утилит последовательность пунктов PlotCtrls → Style → 

Size and Shape. 

Сохранить полученное изображение можно различными способами, самым 

простым из которых является использование команды Image Capture. Вызов этой 

команды производится при помощи одноименной кнопки на стандартной панели 

инструментов (рисунок 2.11). При нажатии на указанную кнопку появляется окно, 

показанное на рисунке 2.12. 

 

 
 

Рисунок 2.11 – Стандартная панель инструментов 
 

 
 

Рисунок 2.12 – Диалоговое окно Image Capture 
 

При нажатии на указанную кнопку появляется окно, показанное на рисунке 

2.12. В этом окне включим переключатель Capture to file и выберем в списке Quality: 

пункт presentation, затем в группе Orientation включим переключатель Portrait и на-

жмем кнопку OK. В результате откроется типовое для Windows-приложений диало-

говое окно для сохранения файлов. При помощи этого окна выберем подходящий 
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графический формат файла (рекомендуется *.png) и сохраним изображение в файл 

под каким-либо осмысленным именем, например Contour.png.   

Полученный график показывает, что максимальное растяжение пружины под 

действием веса груза в данном случае приблизительно составляет 0,064 м. Для про-

смотра более точных значений перемещений по каждому узлу модели можно вос-

пользоваться числовой формой представления результатов.  

Просмотр расчетных перемещений по всем узлам модели возможен путем вы-

бора в главном меню последовательности пунктов General Postproc → List Results → 

Nodal Solution. Последний пункт данной последовательности вызывает на экран ок-

но List Nodal Solution, аналогичное окну на рисунке 2.7. Здесь в списке Item to be 

Listed требуется последовательно выбрать пункты Nodal Solution → DOF solution → 

Displacement vector sum и нажать кнопку OK.    

После этого в специальном окне (рисунок 2.13) будут выведены результаты 

расчета перемещений в виде числовых значений расчетных перемещений по трем 

линейным координатам, а также их векторной суммы. В нижней строке для каждой 

колонки результатов приводятся максимальные по абсолютной величине значения.  

 

 
 

Рисунок 2.13 – Окно просмотра числовых значений результатов 
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Аналогичным способом можно вывести на экран расчетное значение веса гру-

за, вызывающего полученные перемещения. Для этого в главном меню нужно вы-

брать пункты General Postproc → List Results → Nodal Loads и вызвать окно List 

Nodal Loads (рисунок 2.14).  

 

 
 

Рисунок 2.14 – Диалоговое окно List Nodal Loads 
 

Далее в этом окне требуется в списке Lab Load to be listed выбрать пункт FY и 

нажать кнопку OK. В результате на экран будут выведены числовые силы, дейст-

вующей в каждом узле модели в направлении оси Y. Последняя строка (TOTAL 

VALUES) списка будет представлять собой их суммарное значение, которое в дан-

ном случае и является весом груза. Для рассматриваемого примера он равняется 

19,3 Н.  

Зная вес груза и вызванное им перемещение можно определить жесткость пру-

жины как отношение силы к перемещению. В данном случае оно составит 0,3 Н/мм.  
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2.7 Определение закона изменения жесткости пружины 

 
Полученное значение жесткости справедливо лишь в том случае, если растя-

жение пружины изменяется в зависимости от нагрузки по линейному закону, что 

наиболее вероятно. Для проверки этого допущения выполним еще один расчет, на-

правленный на определение закона, которому подчиняется жесткость пружины. 

Для проведения этого расчета, прежде всего, удалим инерционную нагрузку, 

приложенную к модели. Ее удаление осуществляется путем выбора в главном меню 

последовательности пунктов Solution → Define Loads → Delete → Structural → Iner-

tia → Gravity и нажатия кнопки OK в окне подтверждения (Delete (Gravitational) Ac-

celeration).  

Далее необходимо приложить к модели цилиндра силовую нагрузку. Прило-

жение нагрузки целесообразно выполнить к плоскости нижнего торца цилиндра. 

Для того чтобы исключить влияние местных деформаций цилиндра, нагрузку следу-

ет прикладывать не в одной точке, а равномерно распределить ее по поверхности 

торца. 

Выполним эту операцию путем активации в главном меню пунктов Solution → 

Define Loads → Apply → Structural → Force/Moment → On Nodes. Это приведет к 

появлению панели управления интерактивным выбором объектов. В данном случае 

она будет настроена на выбор узлов модели. 

После появления панели сначала переключимся на режим отображения узлов 

(Plot → Nodes) и вид спереди (кнопка Front View  справа от графической зоны). 

Далее на активной панели выбора включим переключатель Box (рисунок 2.15), а за-

тем, зажав левую кнопку мыши, обведем рамкой все узлы, принадлежащие нижнему 

торцу цилиндра (рисунок 2.16).         

 

 
 

Рисунок 2.15 – Включение режима выбора рамкой 
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Рисунок 2.16 – Выбор узлов при помощи рамки 
 

Когда необходимые узлы модели будут выбраны, их общее число будет пока-

зано в строке Count, присутствующей на панели выбора (в данном случае 101 узел). 

Запомним или запишем это число, а затем нажмем кнопку OK, что приведет к появ-

лению диалогового окна Apply F/M on Nodes (рисунок 2.17). 

 

 
 

Рисунок 2.17 – Диалоговое окно Apply F/M on Nodes 
 

В комбинированном списке Lab Direction of force/mom текущего окна выберем 

пункт FY, после чего введем в поле VALUE значение действующей силы в виде вы-

ражения минус 20/101. Где 20 – округленный в большую сторону до целого числа 
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вес груза, а 101 – количество выбранных узлов (знак минус указывает на то, что 

прикладываемая сила будет направлена вниз). Сделав необходимые изменения, за-

кроем окно кнопкой OK. В случае правильности выполненной операции приложен-

ная нагрузка отобразиться на модели в виде направленных вниз стрелок, связанных 

с выбранными узлами.  

Завершив определение условий нагружения модели, далее изменим настройки 

решения. Для этого в главном меню последовательно задействуем пункты Solution 

→ Analysis Type → Sol’n Controls, что приведет к появлению программного окна, 

изображенного на рисунке 2.18. 

 

 
 

Рисунок 2.18 – Вкладка Basic диалогового окна Solution Controls 
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На вкладке Basic текущего окна перейдем к группе компонентов Time Control, 

где в списке Automatic time stepping выберем пункт Off, затем включим переключа-

тель Number of substeps и запишем в поле Number of substeps значение равное 10. 

После этого в комбинированном списке Frequency: выберем пункт Write every sub-

step и нажмем кнопку OK.  

Заданные настройки определяют процедуру решения как последовательность 

из 10 шагов, на каждом из которых будет производиться расчет перемещений под 

действием приложенной нагрузки. Но нагрузка на каждом шаге будет разной, ли-

нейно возрастающей до своего максимального значения (заданного при приложении 

силы) с увеличением номера шага. То есть, при числе шагов равном 10, на первом 

шаге нагрузка будет составлять 1/10 от максимума, на втором – 2/10 и т.д.    

После внесения необходимых изменений в настройки решения запустим рас-

чет, для чего активируем в главном меню пункты Solution → Solve → Current LS. 

При удачном завершении расчета на экран будет выведено окно сообщения Solution 

is done!. Закроем это окно и приступим к просмотру полученных результатов. 

В данном случае удобно просмотреть результаты в виде графика, для построе-

ния которого воспользуемся командами постпроцессора TimeHist Postpro, предна-

значенного для обработки результатов нестационарных расчетов.    

При входе в этот постпроцессор автоматически запустится команда Variable 

Viewer и откроется окно Time History Variables (рисунок 2.19). Данное окно предна-

значено для управления переменными являющимися функциями времени. Список 

доступных переменных отображается в поле Variable List. В этом списке всегда при-

сутствует автоматически создаваемая переменная TIME. Так как в данном случае 

время расчета не задавалось, то оно по умолчанию было принято равным 1 с, и, со-

ответственно переменная TIME будет содержать десять значений от 0,1 до 1 с.  

Для добавления новой переменной, которая будет содержать значения пере-

мещений на каждом шаге расчета, на панели инструментов в текущем окне нажмем 

кнопку  – Add Data. В результате появится еще одно окно (рисунок 2.20), в кото-

ром будет предложено выбрать доступные для создания переменной результаты. 

Здесь последовательно откроем пункты Nodal Solution и DOF Solution, а затем выде-

лим строку Y-component of displacement и нажмем кнопку OK. 



53 

 
 

Рисунок 2.19 – Окно Time History Variables 
 

 
 

Рисунок 2.20 – Окно Add Time-History Variable 
 

После этого появится панель выбора, настроенная на выбор одного узла, для 

которого нужно извлечь результаты. В качестве такого узла выберем узел, располо-

женный в центре нижнего торца цилиндра. Следует заметить, что окно Time History 
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Variables является не модальным, и поэтому при выборе узла его можно просто сме-

стить в сторону так, чтобы оно не перекрывало обзор. 

Выбор узла приведет к появлению в поле Variable List еще одной переменной 

с именем UY_2 (при желании, создаваемой переменной можно назначить любое 

другое имя путем его указания в строке Variable Name в окне Add History Variable). 

Так как исследуемая зависимость представляет собой зависимость перемеще-

ния от нагрузки, то необходимо создать еще одну переменную со значениями силы. 

В данном случае такую переменную проще всего создать искусственно при помощи 

калькулятора окна Time History Variables (на рисунке 2.19 он показан в свернутом 

состоянии).  

Для создания переменной в поле в левом верхнем углу калькулятора (слева от 

знака равно) запишем имя переменной, например F. В соседнее с ним поле (справа 

от знака равно) запишем определяющее переменную выражение вида 20*{TIME}. 

Здесь 20 – значение приложенной силы, а {TIME}– переменная TIME (при исполь-

зовании в калькуляторе активных переменных их имена обязательно заключаются в 

фигурные скобки). После ввода необходимого выражения щелкнем по кнопке 

ENTER или нажмем клавишу Enter на клавиатуре (рисунок 2.21). В случае успешно-

го ввода выражения в поле Variable List добавится переменная F, содержащая значе-

ния силы, действующей на каждом шаге решения. 

 

 
 

Рисунок 2.21 – Калькулятор окна Time History Variables 
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Полученные переменные можно просмотреть как в виде графика, так и в виде 

набора числовых значений. Для построения графика зависимости перемещения от 

силы необходимо, во-первых, в столбце X-Axis поля Variable List включить пере-

ключатель, расположенный в строке переменной F (по умолчанию этот переключа-

тель включен для строки TIME). Во-вторых, выделить строку переменной UY_2 и 

щелкнуть по кнопке  – Graph Data на панели инструментов активного окна. В ре-

зультате на экране появится график (рисунок 2.22), показывающий, что зависимость 

удлинения пружины от нагрузки действительно имеет линейный характер.    

 

 
 

Рисунок 2.22 – График зависимости удлинения пружины от нагрузки 
 

Полученный график сохранять не нужно. В данном случае требуется сохра-

нить результаты в числовой форме. Для вывода на экран числовых значений пере-

менных, удерживая клавишу Ctrl, выделим в поле Variable List строки переменных 

UY_2 и F. После этого щелкнем по кнопке  – List Data на панели инструментов 

активного окна.  

В результате появится окно (рисунок 2.23) с тремя столбцами числовых зна-

чений, соответствующих выделенным переменным (столбец переменной TIME все-

гда включается в список автоматически). Чтобы сохранить отображенные данные в 

файл войдем в пункт меню File, присутствующий в открытом окне и запустим из не-
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го команду Save as. Далее при помощи стандартного окна Windows сохраним дан-

ные в файл. Следует заметить, что сохраняемый файл по умолчанию получить ори-

гинальное расширение *.lis. Для удобства дальнейшего использования файла лучше 

сохранить его с расширением *.txt, что легко сделать, просто добавив нужное рас-

ширение к имени файла в строке Имя файла:, например Stat_results.txt. 

 

 
 

Рисунок 2.23 – Окно просмотра числовых значений переменных 
 

В завершении, закроем все открытые программные окна и сохраним измене-

ния сделанные в модели. Для этого из пункта File меню утилит снова запустим ко-

манду Save as и пересохраним файл модели.  

 

2.8 Контрольные вопросы 

 

1 Как в ANSYS осуществляется выбор вида расчета? 

2 При помощи какой команды можно изменить настройки решения? 

3 Каким образом определяются условия закрепления модели? 

4 Каким образом задается инерционная нагрузка? 

5 Каким образом к модели прикладывается силовая нагрузка? 

6 При помощи какой команды производится запуск процедуры решения? 

7 Для чего предназначен постпроцессор General Postproc? 
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8 В чем заключаются особенности построения контурных графиков по резуль-

татам расчета? 

9 Как производится настройка графической зоны ANSYS при визуализации 

результатов? 

10 Для чего предназначен постпроцессор TimeHist Postpro? 

11 Какие функции выполняет программное окно Time History Variables? 
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3 Лабораторная работа №3. Динамический расчет пружинного 

маятника 
 

Цель работы: ознакомление с особенностями проведения нестационарных 

расчетов в ANSYS, закрепление навыков наложения граничных условий и приобре-

тение умения обрабатывать результаты расчета с использованием средств постпро-

цессора TimeHist Postpro. 

 

3.1 Описание решаемой задачи 

  

При проведении описываемого расчета объектом исследования будут являться 

свободные затухающие колебания груза, происходящие вдоль оси пружины. Реали-

зация такого расчета предполагает его проведение в два этапа. На первом этапе ма-

ятник должен быть выведен из состояния равновесия путем смещения груза на не-

которую величину от исходного положения. Соответственно, на втором этапе маят-

нику обеспечивается возможность совершения свободных колебаний, параметры 

которых зависят от размеров и материала пружины, а также массы груза. Результа-

тами расчета будут являться: закон, по которому осуществляются свободные коле-

бания маятника, частота и декремент колебаний. 

 

3.2 Определение условий закрепления модели 

 

После загрузки файла модели (File → Resume from) переключимся в режим 

отображения элементов (Plot → Elements) и посмотрим, какие условия закрепления 

уже присутствуют в модели. Такими условиями будут являться нулевые степени 

подвижности, наложенные на верхний виток модели пружины. Для проведения рас-

сматриваемого расчета этих условий будет недостаточно, поскольку при таком за-

креплении маятник может совершать колебания не только вдоль оси пружины, но и 

в перпендикулярных ей направлениях, а также совершать крутильные колебания во-

круг оси пружины. 
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Чтобы исключить возможность этих колебаний необходимо задать дополни-

тельные условия закрепления, определенным образом фиксирующие модель цилин-

дра в пространстве. Данные условия будем задавать на узлах, принадлежащих ци-

линдрической поверхности модели. Для этого сначала отделим необходимые узлы 

от их общей совокупности при помощи средств уже знакомой панели Select Entities 

(рисунок 1.31). 

Вызвав на экран эту панель (Select → Entities), выберем в ее верхнем комби-

нированном списке пункт Nodes и включим переключатель Unselect. Затем нажмем 

кнопку OK, после чего программа при помощи панели управления интерактивным 

выбором предложит выбрать узлы модели, подлежащие деактивации.  

Перед тем как сделать этот выбор включим режим отображения узлов (Plot → 

Nodes) и переключим изображение модели на вид сверху  – Top View. Далее на 

панели интерактивного выбора включим переключатель Circle (рисунок 3.1), а затем 

наведем острие стрелки курсора точно на центральный узел модели и прижмем ле-

вую кнопку мыши. При смещении мыши в сторону появится выделяющий круг. За-

фиксируем размер этого круга так, чтобы он охватил все узлы модели кроме узлов, 

принадлежащих цилиндрической поверхности цилиндра, т.е. наиболее удаленных от 

центра (рисунок 3.2). После того как необходимые узлы будут выбраны, нажмем 

кнопку OK на панели выбора. Для визуализации полученного результата запустим 

команду Replot. При этом выбранные узлы должны исчезнуть с экрана. 
 

 
 

Рисунок 3.1 – Включение режима выбора окружностью 
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Рисунок 3.2 – Выбор узлов при помощи выделяющей окружности 
 

На оставшиеся активные узлы теперь наложим требуемые условия закрепле-

ния, для чего в главном меню задействуем последовательность пунктов Solution → 

Define Loads → Apply → Structural → Displacement → On Nodes. На появившейся 

вслед за этим панели выбора просто нажмем кнопку Pick All, что обеспечивает ав-

томатический выбор всех активных узлов. Затем в окне выбора степеней свободы 

(рисунок 2.4) в списке Lab2 выделим пункты UX и UZ и, задав в поле VALUE зна-

чение равное нулю, нажмем кнопку OK.  

Завершив определение условий закрепления, снова активируем все неактив-

ные узлы, которые были отключены ранее. Для этого из пункта Select меню утилит 

запустим команду Everything. 

 
3.3 Реализация первого шага решения 

 
На первом шаге решения необходимо вывести маятник из состояния равнове-

сия. Выполним это условие посредством наложения ненулевых степеней свободы на 

узлы, принадлежащие плоскости нижнего торца на модели цилиндра. Перед этим 

необходимо удалить силовую нагрузку, заданную при выполнении предыдущей ра-

боты. Для ее удаления в главном меню выберем пункты Solution → Define Loads → 

Delete → Structural → Force/Moment → On Nodes, а затем нажмем кнопку Pick All на 

панели интерактивного выбора. В результате появится окно Delete F/M on Nodes 

(рисунок 3.3). В этом окне в списке Lab Force/Moment to be deleted выберем пункт 

ALL и нажмем кнопку OK. 
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Рисунок 3.3 – Окно Delete F/M on Nodes 
 

После удаления силовой нагрузки снова активируем последовательность 

пунктов Solution → Define Loads → Apply → Structural → Displacement → On Nodes. 

При появлении панели интерактивного выбора, ранее рассмотренным способом (с 

помощью рамки) выделим узлы, соответствующие нижнему торцу цилиндра (рису-

нок 2.16). В окне выбора ограничиваемых степеней свободы (рисунок 2.4) в списке 

Lab2 выберем пункт UY (перемещение вдоль оси пружины) и назначим ему в поле 

VALUE величину равную минус 0,01 м. Применим сделанные изменения кнопкой 

OK и перейдем к следующему этапу. 

На следующем этапе необходимо настроить опции первого шага решения. Для 

этого предварительно требуется оценить период колебаний маятника. При извест-

ных массе груза и жесткости пружины период колебаний пружинного маятника мо-

жет быть легко определен по аналитической формуле. Рассчитаем этот период в ви-

де числового параметра модели.  

Для управления числовыми (скалярными) параметрами модели предназначено 

окно Scalar Parameters (рисунок 3.4), вызываемое из пункта Parameters меню утилит 

соответствующей одноименной командой [5]. Чтобы создать необходимый параметр 

в строке Selection вызванного окна запишем выражение вида T = 2*ACOS(-

1)*SQRT(2/302). Здесь T – имя создаваемого параметра, ACOS(-1) – выражение, оп-

ределяющее точное значение числа π, 2 – масса груза в кг, 302 – расчетная жест-

кость пружины в Н/м. Перед вводом приведенного выражения нужно выбрать в ка-

честве единицы измерения углов радианы (Radians), для чего используем окно An-

gular Units for Parametric Functions, вызываемое последовательностью пунктов Pa-

rameters → Angular Units в меню утилит.  
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Рисунок 3.4 – Окно управления скалярными параметрами Scalar Parameters 
 

После записи приведенного выражения нажмем кнопку Accept, в результате 

чего в поле Items должно появиться числовое значение заданного параметра (для 

рассматриваемого примера оно будет равно 0,511 с). Далее использование окна Sca-

lar Parameters не требуется, поэтому закроем его кнопкой Close. 

Определив период колебаний в виде параметра T, воспользуемся последова-

тельностью пунктов главного меню Solution → Analysis Type → New Analysis и вы-

зовем окно New Analysis (рисунок 2.1), служащее для выбора вида расчета. В дан-

ном случае здесь нужно включить переключатель Transient и подтвердить сделан-

ный выбор кнопкой OK. В окне Transient Analysis (рисунок 3.5), появившемся вслед 

за этим и служащим для выбора метода решения, включим переключатель Full, а за-

тем нажмем кнопку OK.   
 

 
 

Рисунок 3.5 – Диалоговое окно Transient Analysis 
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После этого активируем пункты Solution → Analysis Type → Sol’n Controls и 

вызовем окно Solution Control, где перейдем на его вкладку Basic (рисунок 2.18). На 

этой вкладке перейдем к группе компонентов Time Control и запишем в поле Time at 

end of loadstep выражение T/20. Затем включим переключатель Time increment и за-

пишем в поле Time step size то же выражение T/20. В комбинированном списке 

Automatic time stepping выберем пункт Off.  

Далее перейдем на вкладку Transient текущего окна (рисунок 3.6) и перейдем к 

группе компонентов Full Transient Options, где снимем флажок Transient effects и 

включим переключатель Stepped loading. Для того чтобы применить выбранные на-

стройки решения нажмем кнопку OK.  

 

 
 

Рисунок 3.6 – Вкладка Transient диалогового окна Solution Controls 
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Чтобы обеспечить возможность повторного использования заданных настроек 

решения сохраним их в специальный файл. Для этого в главном меню последова-

тельно выберем пункты Solution → Load Step Opts → Write LS File. В появившемся 

окне Write Load Step File (рисунок 3.7) в поле LSNUM Load step file number n зада-

дим номер шага решения равный единице и нажмем кнопку OK. 

 

 
 

Рисунок 3.7 – Окно Write Load Step File 
 

Как только будут заданы и сохранены настройки решения, запустим расчет, 

для чего в главном меню выберем пункты Solution → Solve → Current LS. После его 

завершения и появления сообщения Solution is done! приступим к реализации второ-

го шага решения. 

 
3.4 Реализация второго шага решения 

 
При выполнении операций, связанных с реализацией второго шага решения, 

важной особенностью является то, что нельзя выходить из пункта Solution в главном 

меню. В противном случае придется снова повторить первый шаг решения, по-

скольку при выходе из пункта Solution будет утрачена связь между первым и вто-

рым шагом. 

Реализацию второго шага решения начнем с того, что удалим ненулевые сте-

пени свободы, заданные на нижнем торце цилиндра. Для их удаления в главном ме-

ню задействуем последовательность пунктов Solution → Define Loads → Delete → 

Structural → Displacement → On Nodes. Затем при помощи выделяющей рамки выбе-

рем необходимые узлы, после чего появится окно Delete Node Constraints, приведен-
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ное на рисунке 3.8. В комбинированном списке Lab DOFs to be deleted этого окна вы-

берем пункт UY и нажмем кнопку OK.    

 

 
 

Рисунок 3.8 – Окно Delete Node Constraints 
 

Далее вызовем окно настроек решения (Solution → Analysis Type → Sol’n Con-

trols), где на вкладке Basic в поле Time at end of loadstep запишем выражение 20*T. 

Затем в списке Frequency: выберем пункт Write every substep, после чего перейдем 

на вкладку Transient. На этой вкладке установим флажок Transient effects и закроем 

окно кнопкой OK.  

Настройки второго шага решения так же сохраним в файл под номером два с 

использованием окна на рисунке 3.7 

Задав настройки решения, запустим расчет (Solution → Solve → Current LS), 

по завершению которого перейдем к просмотру полученных результатов. Следует 

заметить, что расчет на втором шаге решения может занять несколько минут в зави-

симости от производительности компьютера. 

 
3.5 Просмотр полученных результатов 

 
Для просмотра результатов решения опять воспользуемся средствами пост-

процессора TimeHist Postpro. Войдем в этот постпроцессор и вызовем окно Time 

History Variables (рисунок 2.19). В поле Variable List этого окна выделим строку пе-

ременной TIME и просмотрим ее числовые значения, для чего нажмем кнопку  – 

List Data на панели инструментов окна. В случае правильно реализованного реше-

ния переменная должна содержать 400 числовых значений, соответствующих сум-

марной продолжительности 20 периодов колебаний.  
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После просмотра числовых значений переменной TIME (и закрытия соответ-

ствующего окна) создадим новую переменную, которая должна содержать переме-

щения выбранной точки цилиндра в различные моменты времени. Эту переменную 

создадим точно также как и в прошлый раз, т.е. щелкнем по кнопке  – Add Data на 

панели инструментов текущего окна, затем в окне Add Time-History Variable (рису-

нок 2.20) выберем пункты Nodal Solution → DOF Solution → Y-component of dis-

placement и нажмем кнопку OK. В качестве узла для создания переменной опять вы-

берем узел, расположенный в центре нижнего торца цилиндра. 

Добавленную переменную (UY_2 по умолчанию)  отобразим на графике, для 

чего выделим строку переменной в поле Variable List и щелкнем по кнопке  – 

Graph Data на панели инструментов. При этом переключатель X-Axis должен быть 

включен для переменной TIME. Полученный в результате этого график должен вы-

глядеть приблизительно так, как показано на рисунке 3.9. График наглядно показы-

вает, как будут затухать амплитуды колебаний маятника с течением времени.  

 

 
 

Рисунок 3.9 – График колебаний маятника 
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По приведенному графику легко определить период, частоту и логарифмиче-

ский декремент затухания, что будет сделано при выполнении последующей рабо-

ты. На текущем этапе требуется сохранить в файл данные, необходимые для по-

строения графика. Для этого сначала подготовим данные для сохранения и с этой 

целью щелкнем по кнопке  – Data Properties на панели окна Time History Variables. 

В результате появится окно настройки свойств переменных Time-History Properties 

(рисунок 3.10). Здесь перейдем на вкладку Lists и в поле Number of lines per page за-

дадим значение равное 400 (по числу значений переменной TIME). После этого за-

кроем окно кнопкой OK. 

 

 
 

Рисунок 3.10 – Диалоговое окно Time-History Properties 
 

Теперь в поле Variable List выделим созданную переменную UY_2, щелкнем 

по кнопке  – List Data и выведем на экран числовые значения переменной. Далее 

рассмотренным выше способом (в меню окна File → Save as) сохраним их в файл с 

каким-либо осмысленным именем, например Dyn_results100.txt. После сохранения 

файла закроем все активные окна, открытые ранее.  

Нужно добавить, что результаты нестационарных расчетов могут быть также 

отображены и в виде контурных графиков. Для этого удобно применить специаль-
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ный программный инструмент Results Viewer. Доступ к нему осуществляется из 

главного меню путем выбора пунктов General Postproc → Results Viewer.  

Это приводит к изменению интерфейса (исчезает главное меню и меню ути-

лит) и появлению панели Results Viewer (рисунок 3.11). Для визуализации результа-

тов при помощи данной панели, прежде всего, необходимо выбрать подлежащие 

отображению на графике результаты. Выполним этот выбор путем входа в комби-

нированный список с надписью Choose a result item и последовательной активации в 

нем пунктов Nodal Solution → DOF Solution → Y-Component of displacement.  

 

 
 

Рисунок 3.11 – Панель Results Viewer 
 

После выбора результатов для отображения станут активными функциональ-

ные кнопки, присутствующие на панели. Чтобы построить контурный график на-

жмем на кнопку  – Plot Results. В результате на экране появится контурный гра-

фик перемещений по координате Y, построенный для начального момента времени. 

Для просмотра графика в другие моменты времени необходимо перемещать присут-

ствующий на панели ползунок вправо от исходного положения. При этом изображе-

ние графика на экране будет автоматически меняться в зависимости от положения 

ползунка.  

Так же можно просмотреть процесс изменения контурного графика в динами-

ке, для чего в ANSYS предусмотрена возможность анимации результатов. Для соз-

дания анимации на панели Results Viewer нужно нажать соответствующую кнопку 

 – Animate Results. Это приведет к появлению на экране окна Select Animation 

(рисунок 3.12), предназначенного для выбора типа создаваемой анимации. Здесь 

включим переключатель Over Results и нажмем кнопку Ok. За этим последует появ-

ление окна Animate Over Results, приведенного на рисунке 3.13.  
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Рисунок 3.12 – Диалоговое окно Select Animation 
 

 
 

Рисунок 3.13 – Диалоговое окно Animate Over Results 
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В этом окне в группе переключателей Model result data включим переключа-

тель Result Set Range, после чего в строке Range Minimum, Maximum зададим диапа-

зон от 1 до 400. В поле Increment result set зададим величину шага равную 2. Затем 

перейдем к группе компонентов Contour data for animation, где в списке категорий 

результатов (слева) выберем пункт DOF solution,а в списке видов результатов (спра-

ва) – пункт Translation UY. После этого нажмем кнопку OK. 

В результате запустится процесс создания анимации, по завершении которого 

на экране отобразится анимированный контурный график и появится панель, позво-

ляющая управлять анимацией (рисунок 3.14). В частности, с ее помощью можно 

управлять скоростью анимации, для чего предназначена полоса прокрутки Delay. 

Крайнее левое положение ее ползунка соответствует максимальной скорости ани-

мации, а крайнее правое – минимальной.  

 

 
 

Рисунок 3.14 – Панель управления анимацией 
 

Завершив просмотр анимации, закроем панель Results Viewer и перейдем к 

выполнению следующего этапа работы, на котором необходимо определить каким 

образом влияет коэффициент демпфирования на амплитуды и скорость затухания 

колебаний маятника. 
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3.6 Расчет колебаний маятника при переменном коэффициенте 

демпфирования 

 

Для определения того, как влияет демпфирование на закон движения маятни-

ка, выполним серию дополнительных расчетов при различных значениях коэффици-

ента демпфирования. Количество расчетов в серии примем равным четырем, соот-

ветственно значения коэффициентов демпфирования будут составлять 20, 60, 140 и 

180% от исходного значения, ранее заданного в модели. 

Для реализации первого расчета, прежде всего, изменим величину коэффици-

ента демпфирования. Эту операцию выполним при помощи окна Define Material 

Model Behavior (рисунок 1.10), вызываемого путем последовательного выбора в 

главном меню пунктов Preprocessor → Material Props → Material Models (рисунок 

1.9). После вызова указанного окна перейдем в нем к полю Material Models Defined, 

где двойным щелчком последовательно активируем пункты Material Model Number 

1 → Damping (Constant). В результате появится окно Damping for Material Number 1 

(рисунок 1.12), в котором изменим текущее значение коэффициента демпфирования 

(0,0075) заменив его выражением 0,0075*0,2.  

Завершив редактирование модели материала, закроем окно Define Material 

Model Behavior и запустим решение. Так как необходимые настройки обоих шагов 

решения были сохранены в файлы, то для запуска решения теперь воспользуемся 

командой From LS Files, доступной в главном меню путем выбора пунктов Solution 

→ Solve → From LS Files.  

Запуск этой команды приведет к появлению диалогового окна Solve Load Step 

Files, приведенного на рисунке 3.15. В этом окне в поле LSMIN зададим номер пер-

вого шага (1), а в поле LSMAX – номер второго шага (2). Приращение номера шага 

(поле LSINC) оставим равным единице. Задав номера шагов, нажмем кнопку OK и 

запустим расчет.  
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Рисунок 3.15 – Диалоговое окно Solve Load Step Files 
 

По завершению расчета для обработки его результатов снова воспользуемся 

постпроцессором TimeHist Postpro. Войдем в него и вызовем окно Time History Vari-

ables (рисунок 2.19). При помощи инструментов этого окна ранее рассмотренным 

способом создадим новую переменную, содержащую в себе перемещения по коор-

динате Y для центрального узла на нижнем торце цилиндра. Числовые значения по-

лученной переменной сохраним в файл, назначив ему соответствующее имя, напри-

мер Dyn_results20.txt. 

Точно таким же образом выполним еще три расчета с различными значениями 

коэффициента демпфирования, составляющими 0,0045 (0,0075*0,6), 0,0105 

(0,0075*1,4) и 0,0135 (0,0075*1,8). По результатам каждого из них создадим пере-

менные, которые сохраним в три отдельных файла с именами Dyn_results60.txt,  

Dyn_results140.txt и Dyn_results180.txt. 

Завершив обработку результатов расчета, сохраним изменения сделанные в 

модели, для чего применим команду Save as из пункта File в меню утилит.  

 

3.7 Контрольные вопросы 

 

1. В чем заключаются особенности проведения нестационарных расчетов в 

ANSYS? 

2 Для чего предназначен первый шаг решения? 

3 Для чего предназначен второй шаг решения? 
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4 Каким образом производится удаление условий закрепления модели? 

5 Каким образом производится удаление силовой нагрузки?  

6 Для каких целей используются скалярные параметры модели?  

7 Каким образом создаются скалярные параметры модели? 

8 Как осуществляется сохранение в файл настроек решения? 

9 Как производится запуск решения с использованием файлов настройки?   

10 Для чего предназначена панель Results Viewer? 

11 Как может быть выполнена анимация результатов при помощи панели ин-

струментов Results Viewer? 
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4 Лабораторная работа №4. Гармонический анализ пружинного 

маятника 
 

Цель работы: изучение особенностей реализации специального вида расчета 

Harmonic Response Analysis, приобретение навыков определения гармонического 

отклика различных конструкций и первичной обработки полученных результатов на 

примере модели пружинного маятника. 

 
4.1 Описание решаемой задачи 

 
Как известно, при динамическом нагружении конструкции величина ее де-

формации будет зависеть не только от величины действующей нагрузки, но и от 

частоты ее изменения. То есть при совпадении частоты возмущающей нагрузки с 

одной из собственных частот колебаний конструкции наблюдается явление резонан-

са, при котором происходит резкое увеличение деформаций.     

В данном случае исследуемой конструкцией будет являться пружинный маят-

ник, для которого при помощи специального вида расчета должен быть определен 

его гармонический отклик на переменную силу. Особенностью расчета является то, 

что сила изменяется по гармоническому закону с заданной постоянной амплитудой 

и переменной частотой, интервал изменения которой задается пользователем [2]. В 

результате расчета должны быть получены частотные характеристики маятника.        

 
4.2 Выбора вида расчета и установок решения 

 
После загрузки в систему файла модели (File → Resume from), перейдем к 

главному меню, где последовательно задействуем пункты Solution → Analysis Type 

→ New Analysis. В появившемся в результате этого окне New Analysis (рисунок 2.1) 

включим переключатель Harmonic и нажмем кнопку OK.   

Далее в главном меню задействуем последовательность пунктов Solution → 

Load Step Opts → Time/Frequenc → Freq and Substps и вызовем на экран диалоговое 

окно Harmonic Frequency and Substep Options, изображенное на рисунке 4.1. В этом 
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окне определим диапазон изменения частоты возмущающей нагрузки, для чего в ле-

вом поле строки [HARFRQ] Harmonic freq range зададим 0, а в ее правом поле запи-

шем выражение вида 3*NINT(1/T). Здесь T – ранее созданный скалярный параметр 

модели равный периоду колебаний маятника, NINT(…) – параметрическая функция 

ANSYS, округляющая значение в скобках до ближайшего целого числа.  

Число подшагов решения, т.е. число частот укладывающихся в данном диапа-

зоне примем равным 200, для чего введем это значение в поле [NSUBST] Number of 

substeps. Среди двух переключателей [KBC] Stepped or ramped b.c. выберем пере-

ключатель Stepped, после его нажмем кнопку OK. 

 

 
 

Рисунок 4.1 – Диалоговое окно Harmonic Frequency and Substep Options 
 

4.3 Наложение граничных условий и запуск расчета 

 
В качестве возмущающей нагрузки для данного случая примем силу, дейст-

вующую в отрицательном направлении оси Y вдоль оси пружины и равномерно 

распределенную по плоскости нижнего торца цилиндра. Амплитуду силы примем 

равной половине силы тяжести, действующей на цилиндр. При этом сама сила тяже-

сти в расчете учитываться не будет, хотя при необходимости она может быть учтена 

путем добавления в модель инерционной нагрузки. 
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Для приложения силы в главном меню последовательно задействуем пункты 

Solution → Define Loads → Apply → Structural → Force/Moment → On Nodes и, пере-

ключившись в режим выбора рамкой, выберем все узлы на нижнем торце модели 

цилиндра (подробно это процедура описана в пункте 2.7). При этом следует запом-

нить общее число выбранных узлов.  

Далее в окне (рисунок 4.2), появившемся после выбора узлов, необходимо за-

дать величину и направление силы. В отличие от окна, появляющегося при наложе-

нии статической нагрузки (рисунок 2.17), данное окно будет иметь несколько иной 

вид, обусловленный тем, что нагрузки при проведении выбранного вида расчета 

рассматриваются как комплексные величины.  

При этом вещественная часть комплексного числа задается в поле VALUE 

Real part of force/mom, а его мнимая часть – в поле VALUE2 Imag part of force/mom 

вызванного окна. В данном случае в поле VALUE зададим выражение минус 

0,5*NINT(2*9,81)/101, а поле VALUE2 оставим пустым (здесь 2 – заданная масса 

груза в кг, 9,81 – ускорение свободного падения в м/с2, 101 – число выбранных уз-

лов).  

В комбинированных списках Lab Direction of force/moment и Apply as соответ-

ственно выберем пункты FY и Constant value. После этого нажмем кнопку OK и за-

вершим работу по приложению нагрузки. 

 

 
 

Рисунок 4.2 – Окно Apply F/M on Nodes при проведении гармонического анализа 
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Для запуска расчета задействуем в главном меню пункты Solution → Solve → 

Current LS. После завершения расчета и появления сообщения Solution is done! при-

ступим к просмотру полученных результатов.  

 
4.4 Обработка полученных результатов 

 
Просмотр и первичную обработку результатов выполненного расчета снова 

выполним при помощи средств постпроцессора TimeHist Postpro. Войдем в него и 

вызовем окно Time History Variables (рисунок 2.19). По умолчанию в список актив-

ных переменных этого окна теперь будет автоматически добавлена переменная 

FREQ, содержащая 200 значений частоты, ограниченных заданным диапазоном.   

На панели инструментов этого окна нажмем кнопку  – Add Data и точно та-

ким же способом, что был рассмотрен ранее, создадим новую переменную, содер-

жащую в себе перемещения выбранного узла по координате Y. В качестве такого 

узла можно использовать любой узел модели цилиндра, но лучше опять выбрать 

узел в центре нижнего торца цилиндра.   

Созданную переменную отобразим на графике, для чего в поле Variable List 

выделим строку переменной и щелкнем по кнопке  – Graph Data на панели инст-

рументов окна (при этом переключатель X-Axis должен быть включен для перемен-

ной FREQ). Полученный график (рисунок 4.3) будет представлять собой амплитуд-

но-частотную характеристику (АЧХ) маятника, т.е. зависимость амплитуды колеба-

ний от частоты. Эта характеристика должна иметь один явно выраженный резо-

нансный пик, соответствующий собственной частоте колебаний маятника. Очевид-

но, что для рассматриваемого примера собственная частота будет составлять 2 Гц. 

Аналогичным способом может быть построена и фазово-частотная характери-

стика (ФЧХ) маятника, т.е. зависимость фазы колебаний от частоты. Но в данном 

случае перед построением графика требуется изменить форму представления ре-

зультатов. Для изменения формы представления результатов служит комбинирован-

ный список Results to view (расположен в верхнем правом углу окна Time History 

Variables), в котором для построения ФЧХ нужно выбрать пункт Phase Angle. Полу-

ченный график ФЧХ должен иметь вид, представленный на рисунке 4.4. 
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Рисунок 4.3 – Амплитудно-частотная характеристика маятника 

 

 
 

Рисунок 4.4 – Фазово-частотная характеристика 

 
Для построения амплитудно-фазовой частотной характеристики (АФЧХ) при-

дется создать две дополнительные переменные, одна из которых будет содержать 

вещественную часть комплексного перемещения, а вторая – его мнимую часть. Пе-

ред созданием этих переменных снова изменим форму представления результатов, 

для чего войдем в комбинированный список Results to view и выберем в нем пункт 

Real. 
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Обе переменные создадим при помощи уже знакомого калькулятора, присут-

ствующего в активном окне (рисунок 2.21). Первой переменной присвоим имя R и 

зададим определяющее ее выражение в виде real({UY_2}). В этом выражении 

real(…) – специальная функция, извлекающая вещественную часть комплексной пе-

ременной, а UY_2 – имя переменной, содержащей значения перемещений, заклю-

ченное в фигурные скобки. Для записи функции real(…) удобно использовать соот-

ветствующую кнопку REAL / IMAG, имеющуюся в калькуляторе. 

Второй переменной присвоим имя I и зададим для нее выражение в виде 

imag({UY_2}). Здесь imag(…) – специальная функция, извлекающая мнимую часть 

комплексной переменной. Для ее записи можно использовать ту же кнопку, но 

предварительно выполнив инверсию кнопок калькулятора при помощи кнопки INV 

в левом нижнем углу окна.  

После создания необходимых переменных, включим переключатель X-Axis 

для переменной R, затем выделим строку переменной I и щелкнем по кнопке  – 

Graph Data на панели инструментов окна. АФЧХ, построенная в результате этого, 

должна иметь вид, представленный на рисунке 4.5.   

 

 
 

Рисунок 4.5 – Амплитудно-фазовая частотная характеристика 
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Так же как и в предыдущих случаях, полученные графики сохранять не нужно. 

Вместо этого нужно сохранить определяющие их числовые данные. Перед сохране-

нием переменных кнопкой  – Data Properties вызовем окно Time-History Properties 

(рисунок 3.10), в котором перейдем на вкладку Lists и зададим в поле Number of 

lines per page значение равное 201, после чего нажмем кнопку OK. 

Следует заметить, что переменную UY_2 нужно сохранить в двух формах: в 

виде значений амплитуды и фазы и в виде значений вещественной и мнимой части. 

В первом случае при выводе числовых значений переменной на экран в списке Re-

sults to view, отвечающем за форму представления результатов, должен быть выбран 

пункт Amplitude, а во втором случае – пункт Real. В итоге должны быть получены 

два текстовых файла с какими-либо осмысленными именами, например Amp_res.txt 

и Comp_res.txt.     

Завершив работу с переменными, закроем все активные окна и выйдем из сис-

темы без сохранения изменений в модели. 

 

4.5 Контрольные вопросы 

 
1 Для чего в ANSYS предназначен специальный вид расчета Harmonic Re-

sponse Analysis? 

2 Каким образом задается диапазон изменения частоты возмущающей нагруз-

ки? 

3 В чем заключается особенность наложения нагрузок при проведении гармо-

нического анализа? 

4 Как может по результатам гармонического анализа быть построена ампли-

тудно-частотная характеристика?   

5 Как может по результатам гармонического анализа быть построена фазово-

частотная характеристика?   

6 Как может по результатам гармонического анализа быть построена ампли-

тудно-фазовая  частотная характеристика?   

 



81 

5 Лабораторная работа №5. Визуализация результатов расчетов 

при помощи двухмерных диаграмм 
 

Цель работы: ознакомление с основными элементами интерфейса автоматизи-

рованной системы обработки данных Origin, изучение особенностей использования 

системы для обработки экспериментальных данных и приобретение навыков по-

строения и редактирования двухмерных графиков в этой системе. 

 
5.1 Использование автоматизированных систем обработки данных  

 

Несмотря на наличие в системе ANSYS достаточно обширного инструмента-

рия для обработки результатов расчетов, выполнять эту обработку проще и эффек-

тивнее в специализированных компьютерных системах, предназначенных для обра-

ботки и анализа экспериментальных данных. Прежде всего, это касается визуализа-

ции результатов в форме диаграмм различного типа.  

Одним из лидеров среди компьютерных программ для визуализации и обра-

ботки экспериментальных данных является автоматизированная система Origin [3]. 

К основным функциям данной системы относятся: построение различных типов 

графиков и разносторонний анализ данных включая аппроксимацию данных, корел-

ляционно-регрессионный анализ, дисперсионный анализ, спектральный анализ и т.д. 

Рассмотрим особенности использования системы Origin для построения двух-

мерных графиков на примере расчетных данных, полученных в ANSYS при выпол-

нении предыдущих работ.  

 
5.2 Подготовка данных для построения двухмерного графика 

 
После запуска автоматизированной системы Origin в ее рабочей зоне по умол-

чанию автоматически открывается дочернее окно типа «рабочая тетрадь» 

(Workbook). Рабочие тетради Origin представляют собой основу для импорта, орга-

низации, хранения, анализа, преобразования и отображения данных. Рабочая тет-

радь имеет структуру электронной записной книжки (рисунок 5.1) и может содер-
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жать от 1 до 121 листа (Worksheets). По умолчанию создаваемая рабочая тетрадь со-

держит один рабочий лист (Sheet1), который содержит две колонки A(X) и B(Y). 

Для построения графика необходимо ввести в эти колонки числовые данные. 

При этом ввод данных возможен тремя способами: вручную с клавиатуры, в автома-

тизированном режиме с использованием специальных функций системы и путем 

импорта данных из файла совместимого формата. В данном случае воспользуемся 

третьим способом, для чего в главном меню программы последовательно задейству-

ем пункты File → Import → Single ASCII. Так же для этой цели можно щелкнуть по 

кнопке  – Import Single ASCII на панели инструментов Standard (рисунок 5.2). 

 

 
 

Рисунок 5.1 – Окно рабочей тетради 
 

 
 

Рисунок 5.2 – Панель инструментов Standard 

 

В результате появится стандартное окно открытия файлов, при помощи кото-

рого откроем текстовый файл Stat_results.txt, сохраненный при выполнении второй 

работы. Перед тем как нажать кнопку «Открыть» в этом окне нужно обязательно ус-

тановить флажок Show Options Dialog: <sheet> (рисунок 5.3). 
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Рисунок 5.3 – Фрагмент окна открытия файлов при импорте данных 
 

После этого на экране появится окно Import and Export: impASC (рисунок 5.4), 

предназначенное для управления настройками импорта из внешнего файла. Здесь 

щелчком по значку «+» последовательно развернем пункты Import Options и File 

Structure (рисунок 5.5), а затем войдем в комбинированный список Numeric Separa-

tors и выберем в нем пункт 1 000,00 (второй снизу списка). Благодаря этому будет 

обеспечено корректное распознавание данных, содержащихся в импортируемом 

файле. Далее снимем флажок Results Log Output в самом низу окна (рисунок 5.4) и 

нажмем кнопку OK. 

  

 
 

Рисунок 5.4 – Диалоговое окно Import and Export: impASC 
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Рисунок 5.5 – Подпункт File Structure в окне Import and Export: impASC 
 

После нажатия на кнопку OK произойдет заполнение колонок активной рабо-

чей тетради числовыми значениями из выбранного файла. При этом автоматически 

добавится третья колонка C(Y), поскольку импортируемый файл содержит три 

столбца данных. 

Первая колонка рабочей тетради A(X) будет содержать значения времени, ко-

торые в данном случае не представляют интереса, и поэтому ее можно удалить. Для 

удаления колонки щелкнем по ее заголовку A(X) левой кнопкой мыши, в результате 

чего колонка должна выделиться черным цветом. Затем на выделенной колонке 

щелкнем правой кнопкой мыши и вызовем контекстное меню, из которого запустим 

команду Delete (фрагмент меню изображен на рисунке 5.6).  

 

 
 

Рисунок 5.6 – Запуск команды Delete из контекстного меню колонки 

 

Оставшиеся две колонки B(Y) (со значениями силы) и C(Y) (со значениями 

перемещений) нужно поменять местами. Для этого зажав левую кнопку мыши на за-

головке колонки B(Y), переместим курсор на заголовок колонки C(Y) и таким обра-
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зом выделим сразу обе колонки. Далее опять вызовем то же контекстное меню и за-

пустим из него команду Swap Columns (рисунок 5.7).  

 

 
 

Рисунок 5.7 – Запуск команды Swap Columns из контекстного меню колонки 
 

Значения перемещений, содержащиеся в колонке B(Y) и выраженные в метрах 

для удобства дальнейшего использования преобразуем в миллиметры. Это преобра-

зование выполним при помощи команды Set Column Values, доступной из контекст-

ного меню выделенной колонки (рисунок 5.8).   

 

 
 

Рисунок 5.8 – Запуск команды Set Columns Values из контекстного меню колонки 
 

Запуск команды приведет к появлению окна Set Values… (рисунок 5.9), пред-

назначенного для обработки данных в колонках при помощи различных математи-

ческих выражений. В текстовом поле под заголовком Col(B) =, присутствующем в 

этом окне, запишем выражение вида 1000*abs(Col(B)). Где abs(…) – функция, выде-

ляющая абсолютное значение числа, Col(B) – предопределенный идентификатор ко-

лонки. Обозначения колонок и функций могут быть записаны как вручную (при по-

мощи клавиатуры), так и с помощью пунктов Col(A) и F(x) меню, имеющегося в ак-

тивном окне. После ввода выражения нажмем кнопку OK, что приведет к требуемо-

му преобразованию данных в колонке B(Y). 
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Рисунок 5.9 – Диалоговое окно Set Values… 

 
Для построения двухмерного графика необходимо, чтобы среди колонок под-

лежащих отображению на графике, обязательно была колонка, связанная с коорди-

натой X. В данном случае обе колонки связаны с координатой Y, о чем свидетельст-

вует идентификатор Y в заголовке колонок. Чтобы изменить координату колонки, 

выделим колонку C(Y), после чего войдем в пункт главного меню Column и задей-

ствуем в нем подпункт Set as X. В результате заголовок выбранной колонки должен 

принять вид C(X). Так же смену координаты колонки можно выполнить и при по-

мощи контекстного меню колонки, где нужно последовательно выбрать пункты Set 

As → X.  

Перед построением графика следует обратить внимание на наличие в рабочем 

листе четырех рядов, имеющих собственные названия Long Name, Units, Comments и 

Sparklines. Ячейки в этих рядах служат для комментирования данных, содержащихся 

в колонках. В данном случае они не нужны, и их желательно удалить. Для удаления 

рядов выделим их при помощи зажатой левой кнопки мыши, а затем правой кнопкой 

мыши вызовем контекстное меню, из которого запустим команду Delete.  

После удаления вспомогательных рядов добавим один основной ряд (с номе-

ром), для чего левой кнопкой мыши выделим первый ряд рабочего листа и правой 

кнопкой мыши вызовем его контекстное меню, из которого запустим команду Insert. 
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Это приведет к появлению в рабочем листе пустого ряда под номером 1. В обе ячей-

ки этого ряда теперь необходимо задать (с клавиатуры) значения равные нулю.     

В результате выполненных операций активная рабочая тетрадь должна выгля-

деть примерно так, как показано на рисунке 5.10.     

 

 
 

Рисунок 5.10 – Рабочая тетрадь с данными, подготовленными к построению графика 
 

5.3 Отображение данных на графике 

 
Для отображения данных на графике выделим в подготовленной рабочей тет-

ради обе колонки, а затем щелкнем по кнопке  – Line + Symbol на панели инстру-

ментов 2D Graphs (рисунок 5.11). Альтернативным вариантом запуска команды яв-

ляется выбор в главном меню пунктов Plot → Line + Symbol → Line + Symbol либо 

таких же пунктов в контекстном меню колонок. 

 

 
 

Рисунок 5.11 – Панель инструментов 2D Graphs 
 

Независимо от способа запуска команды на экране должно появиться еще од-

но окно, содержащее график, построенный по выбранным данным и изображающий 

зависимость удлинения пружины (перемещения груза) от силы. При этом данная за-
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висимость построена в прямоугольной системе координат и изображена в виде ком-

бинации точек и линии, проходящей через эти точки. Исходный вид полученного 

графика приведен на рисунке 5.12. 

 

 
 

Рисунок 5.12 – Исходный вид графика зависимости перемещения от силы 
 

5.4 Редактирование полученного графика 

 
Изображение полученного графика необходимо отредактировать согласно 

требованиям, предъявляемым к подобным диаграммам. Редактирование графика 

начнем с изменения внешнего вида линии и символов, изображающих зависимость. 

Для доступа к соответствующим настройкам щелкнем правой кнопкой мыши на лю-

бом свободном месте внутри графика и запустим из появившегося контекстного ме-

ню команду Plot Details. В результате должно появиться одноименное диалоговое 

окно. То же самое можно сделать путем последовательного выбора в главном меню 

пунктов Format → Plot либо просто путем двойного щелчка на изображении зависи-

мости.  
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В появившемся окне перейдем на вкладку Line (рисунок 5.13) и в выпадаю-

щем списке Connect выберем тип соединительной линии B-Spline. Затем при помо-

щи списка Width назначим линии толщину равную 2. После этого в группе компо-

нентов Symbol/Line interface снимем флажок Gap to Symbol и нажмем кнопку Apply.  

 

 
 

Рисунок 5.13 – Вкладка Line окна Plot Details 
 

Далее перейдем на соседнюю вкладку Symbol (рисунок 5.14) и щелкнем здесь 

по кнопке, расположенной справа от поля Preview. В результате появится таблица 

символов, которые можно использовать для обозначения точек на графике. Среди 

них щелчком левой кнопки мыши выберем символ в виде пустого круга , после 

чего, вернувшись к вкладке Symbol, еще раз нажмем кнопку Apply. 
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Рисунок 5.14 – Вкладка Symbol окна Plot Details 
 

Завершив работу с опциями отображения линии и символов, изменим размеры 

и опции отображения всего графика. Для этого в иерархическом списке в левой час-

ти окна Plot Details (на рисунках 5.13 и 5.14 он свернут при помощи кнопки ) вы-

делим пункт Layer1, что приведет к изменению содержимого правой части окна. Те-

перь здесь появятся четыре вкладки, среди которых сначала задействуем вкладку 

Size/Speed (рисунок 5.15). На этой вкладке, прежде всего, войдем в комбинирован-

ный список Units, служащий для выбора единиц измерения графика, и выберем в 

нем пункт mm. После этого в поле Width зададим ширину графика равную 120 мм, а 

в поле Height – высоту графика равную 80 мм. Чтобы применить сделанные измене-

ния нажмем кнопку Apply.   

Задав размеры графика, перейдем на вкладку Display (рисунок 5.16). Здесь 

включим переключатель Fixed Factor: и зададим в соседнем с ним текстовом поле 

масштабный коэффициент равный 1. Затем перейдем к группе компонентов Data 

Drawing Options, где снимем флажок Clip Data to Frame. После этого нажмем кнопку 

OK и закроем окно Plot Details. 
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Рисунок 5.15 – Вкладка Size/Speed окна Plot Details 
 

 
 

Рисунок 5.16 – Вкладка Display окна Plot Details 
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Дальнейшее изменение внешнего вида графика связано с редактированием ко-

ординатных осей. Для доступа к настройкам координатных осей щелкнем правой 

кнопкой мыши на свободном месте внутри графика и из появившегося контекстного 

меню запустим команду Axis. В результате откроется окно настройки координатных 

осей графика, которое так же может быть вызвано путем выбора в главном меню 

пунктов Format → Axes → X Axis либо просто путем двойного щелчка по оси X 

графика.   

При таких способах вызова окна (возможны и другие), оно по умолчанию от-

кроется с активной вкладкой Scale (рисунок 5.17), служащей для настройки масшта-

ба координатных осей и откладываемого на них диапазона величин. Здесь незави-

симо друг от друга можно задать настройки для осей X и Y. Переключение между 

осями осуществляется путем щелчка левой кнопкой мыши по пиктограммам Hori-

zontal (ось X) и Vertical (ось Y) в поле Selection: рассматриваемой вкладки. 

 

 
 

Рисунок 5.17 – Вкладка Scale окна настройки свойств осей 

 

Настройку масштаба осей начнем с горизонтальной оси X. Для этого в поле 

From (начальное значение диапазона, откладываемого на оси) зададим первое зна-

чение из колонки C(X) в рабочей тетради, то есть нуль. В поле To (конечное значе-
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ние диапазона) зададим последнее значение из колонки C(X), но округленное в 

большую сторону до ближайшего четного числа (для рассматриваемого примера это 

значение будет равняться 20). После указания пределов диапазона необходимо за-

дать на сколько интервалов будет разбит этот диапазон. Для этого в поле рядом с 

включенным переключателем Increment введем величину интервала (шаг), которую 

выберем таким образом, чтобы весь диапазон делился на целое число интервалов (не 

меньше 5). В данном случае примем величину интервала равной 4.  

Далее переключимся на ось Y и зададим в поле From начальное значение диа-

пазона тоже равное нулю. В поле To зададим максимальное значение из колонки 

B(X), округленное в большую сторону до целого числа, но таким образом, чтобы 

весь диапазон делился на целое число интервалов (также не менее 5) в зависимости 

от величины интервала (Increment). В данном случае конечное значение примем 

равным 70, при величине диапазона равной 10. 

Нужно заметить, что для переключения между окнами графика и рабочей тет-

ради (например, для просмотра максимальных значений в колонках) проще всего 

использовать обозреватель проекта Project Explorer (рисунок 5.18). По умолчанию 

окно обозревателя проекта прикреплено к левой границе графической зоны Origin. 

При его отсутствии на экране, оно легко может быть включено путем выбора в 

главном меню пунктов View → Project Explorer либо щелчка по кнопке Project Ex-

plorer на панели инструментов Standard (рисунок 5.2). 

 

 
 

Рисунок 5.18 – Окно обозревателя проекта Project Explorer 



94 

При помощи обозревателя можно создавать новые и удалять существующие 

окна проекта, переименовывать и группировать их, включать или отключать показ 

окон на экране. Переключение между окнами производится путем двойного щелчка 

по пиктограмме окна в столбце Long Name. 

После внесения изменений в настройки осей на вкладке Scale нажмем кнопку 

«Применить» и перейдем на соседнюю вкладку Title & Format (рисунок 5.19). Здесь 

в поле Selection выберем пиктограмму Bottom (горизонтальная ось), после чего вой-

дем в комбинированный список Major Ticks, управляющий видом и ориентацией 

основных делительных штрихов на оси, и выберем в нем пункт None. Затем войдем 

в соседний список Minor Ticks, управляющий вспомогательными штрихами на оси, 

и выберем в нем пункт In. Далее эти же действия нужно повторить для вертикаль-

ной оси (пиктограмма Left в поле Selection). При установке флажка Ticks в группе 

компонентов Apply To для горизонтальной оси этот повтор будет выполнен автома-

тически. 

 
 

Рисунок 5.19 – Вкладка Title & Format окна настройки свойств осей 
 

Задав необходимые настройки на вкладке Title & Format, нажмем кнопку 

«Применить», после чего перейдем к следующей вкладке Grid Lines (рисунок 5.20). 

Данная вкладка служит для управления параметрами координатной сетки, отобра-
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жаемой на графике. Здесь сначала выберем пиктограмму Horizontal в поле Selection, 

а затем установим флажок Major Grids, тем самым, включив отображение основных 

линий сетки.  

После этого станут доступны компоненты, управляющие цветом, толщиной и 

типом линий сетки. В данном случае изменим только цвет линий, для чего нажмем 

на кнопку с образцом текущего цвета в строке Lines Color и выберем из появившей-

ся палитры черный цвет. Для автоматического применения выбранных настроек для 

вертикальной оси установим флажок Grid Lines в группе Apply To. Перед тем как 

нажать кнопку «Применить», для обеих осей установим флажки Opposite в группе 

Additional Lines. 

 

 
 

Рисунок 5.20 – Вкладка Grid Lines окна настройки свойств осей 
 

Далее перейдем на вкладку Tick Labels (рисунок 5.21), служащую для управ-

ления отображением числовых обозначений осей. Здесь изменим только размер и 

стиль шрифта. Для этого в комбинированном списке Point выберем размер шрифта 

равный 16 точкам и установим флажок Bold (полужирный шрифт). При этом в поле 

Selection должна быть выбрана либо пиктограмма Bottom (горизонтальная ось), либо 

пиктограмма Left (вертикальная ось). Для автоматического применения настроек ко 
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второй оси установим флажки Point и Bold в группе Apply To. После этого закроем 

окно кнопкой OK. 

 

 
 

Рисунок 5.21 – Вкладка Tick Labels окна настройки свойств осей 
 

В завершение необходимо отредактировать метки (обозначения) координат-

ных осей. Согласно требованиям, предъявляемым к диаграммам, обозначение оси 

должно состоять из символьного обозначения величины, откладываемой по оси, 

стрелки, указывающей направление роста величины и обозначения единиц измере-

ния величины. По умолчанию метки осей графика будут соответствовать именам 

колонок рабочей тетради, содержащей данные ля построения графика. То есть в 

данном случае ось абсцисс будет иметь метку C, а ось ординат – метку B. 

Исправление меток начнем с горизонтальной оси. Для этого щелчком левой 

кнопки мыши по метке оси выделим ее. На выделенной метке щелкнем правой 

кнопкой мыши и вызовем контекстное меню, из которого запустим команду Proper-

ties. В результате на экране появится диалоговое окно, приведенное на рисунке 5.22.  

В этом окне сначала перейдем к выпадающему списку для выбора шрифта и 

выберем в нем пункт Arial CYR. Затем в списке Size выберем размер шрифта рав-

ный 18 точкам. После этого перейдем к редактируемому текстовому полю в средней 
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части окна и, удалив имеющееся там обозначение, введем с клавиатуры новое обо-

значение оси в виде латинской буквы F (общепринятый символ для условного обо-

значения силы).  

Добавленное обозначение выделим левой кнопкой мыши (как обычный текст) 

и щелкнем по кнопке  на панели инструментов, присутствующей в окне. В ре-

зультате к обозначению будет применен полужирный стиль шрифта, и оно примет 

вид, показанный в специальном поле внизу окна. При этом в редактируемом поле 

будет показано кодированное изображение с тэгом /b, принятым в программе для 

кодировки полужирного стиля текста. Чтобы применить сделанные изменения на-

жмем кнопку OK.  

 

 
 

Рисунок 5.22 – Диалоговое окно Object Properties 
 

Далее аналогичную процедуру выполним для метки вертикальной оси. При 

этом для обозначения оси используем строчную латинскую букву d, которую затем 

преобразуем в греческую букву δ путем добавления тэга /g. Для добавления этого 

тэга, необходимо полностью выделить обозначение в редактируемом поле и щелк-

нуть по кнопке  на панели инструментов окна. В результате правильно кодиро-
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ванное обозначение должно принять вид \g(\b(d)). По умолчанию метка вертикаль-

ной оси повернута на угол в 90° к горизонтали. Для того чтобы отменить этот пово-

рот войдем в комбинированный список Rotate (deg.) и выберем в нем угол поворота 

равный нулю (либо введем с клавиатуры). После этого закроем окно кнопкой OK. 

Добавленные метки теперь необходимо дополнить стрелками, указывающими 

направление осей. Для их добавления воспользуемся кнопкой  – Arrow Tool на 

панели инструментов Tools (рисунок 5.23). 

 

 
 

Рисунок 5.23 – Панель инструментов Tools 
 

После нажатия на обозначенную кнопку необходимо, удерживая клавишу 

Shift, щелчком левой кнопки мыши на поле графика последовательно указать начало 

и конец стрелки. При этом для горизонтальной оси стрелка строится слева направо 

правее метки оси, а для вертикальной оси – снизу вверх выше метки оси. Длина 

стрелки не должна превышать 1/5 от общей длины оси.  

Далее добавим осям обозначения единиц измерения, которые принято поме-

щать между предпоследним и последним числовым значением на шкале оси. Эти 

обозначения проще всего создать с использованием текстовых надписей, которые 

могут быть вставлены в график. Для вставки текстовой надписи предназначена 

кнопка  – Text Tool на панели инструментов Tools (рисунок 5.23).  

При помощи этого инструмента добавим горизонтальной оси обозначение 

единиц измерения в виде символа Н (ньютоны), а вертикальной оси – в виде симво-

ла мм (миллиметры). Формат надписей примем таким же, как и для меток осей, т.е. 

шрифт Arial CYR, размер 18 точек, стиль полужирный. В данном случае для форма-

тирования текста удобно использовать панель инструментов Format, приведенную 

на рисунке 5.24. 
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Рисунок 5.24 – Панель инструментов Format 
 

После добавления обозначений единиц измерения график должен принять 

свой окончательный вид, соответствующий в общих чертах рисунку 5.25. 

 

 
 

Рисунок 5.25 – Окончательный вид графика зависимости перемещения от силы 
 

Нужно заметить, что по умолчанию в верхнем правом углу графика будет ото-

бражена его легенда (поле с изображением фрагмента кривой на графике). В данном 

случае она и не нужна, и ее желательно удалить из графика. Для удаления необхо-

димо выделить легенду щелчком левой кнопки мыши и нажать клавишу Delete. 

Полученный график сохраним как составную часть проекта, и как независи-

мое от проекта изображение. Для сохранения проекта используем команду Save Pro-

ject As из пункта File главного меню, а для сохранения изображения – командой Ex-

port Graphs из тоже пункта меню. В результате запуска команды Export Graphs поя-

вится окно Import and Export: expGraph (рисунок 5.26), позволяющее настроить па-

раметры экспорта изображения. 
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Рисунок 5.26 – Диалоговое окно Import and Export: expGraph 
 

В этом окне в списке Image Type выберем необходимый графический формат 

файла (рекомендуется *.png), в поле File Name(s) зададим имя файла, а в поле Path 

укажем директорию для сохранения файла. После этого нажмем кнопку OK и со-

храним изображение графика в файл выбранного формата. При необходимости пе-

ред сохранением можно изменить параметры экспорта, такие как размер изображе-

ния, его разрешение и т.п. 

 
5.5 Построение дополнительных графиков 

 
Для закрепления полученных навыков построим и сохраним еще четыре ана-

логичных графика по данным, полученным в ходе выполнения расчетов в ANSYS. 

При этом необходимо учесть ряд следующих моментов. 

Так для построения графика зависимости перемещения от времени требуется 

импорт данных из файла Dyn_results100.txt. Перед тем как импортировать данные 

необходимо добавить пустую рабочую тетрадь в уже существующий проект, но 
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лучше закрыть его и создать новый проект сразу готовый к импорту данных. Для 

создания проекта просто щелкнем по кнопке  – New Project на панели инструмен-

тов Standard (рисунок 5.2).  

После импорта данных из указанного файла в рабочую тетрадь, она будет со-

держать две колонки A(X) и B(Y). В колонке A(X) будут содержаться значения вре-

мени в секундах, а в колонке B(Y) – значения перемещений в метрах, которые ранее 

рассмотренным способом необходимо перевести в миллиметры (формула должна 

иметь вид 1000*Col(B)). Менять колонки местами в данном случае не нужно. 

Отображение данных на графике выполним при помощи кнопки  – Line на 

панели инструментов 2D Graphs (рисунок 5.11) либо путем последовательного вы-

бора пунктов Plot → Line → Line из контекстного меню выделенных колонок. При 

таком способе построения кривая зависимости будет показана в виде простой линии 

без символов, изображающих точки.  

Редактирование размеров графика, параметров линии зависимости и свойств 

координатных осей выполним точно так же, как и предыдущем случае. При этом го-

ризонтальной оси присвоим метку t с единицей измерения секунды (с), а вертикаль-

ной оси – метку δ с единицей измерения миллиметры (мм). Полученный график в 

итоге должен иметь вид, показанный на рисунке 5.27. 

 

 
 

Рисунок 5.27 – График зависимости перемещения от времени 
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Для построения графиков АЧХ и ФЧХ создадим новый проект и импортируем 

в него данные из файла Amp_res.txt. После импорта данных в колонке A(X) рабочей 

тетради будут содержаться значения частоты в герцах, в колонке B(Y) – значения 

амплитуды перемещений в метрах и в колонке C(Y) – значения фазы в градусах. 

Значения в колонке B(Y) необходимо перевести в миллиметры. 

Для того чтобы получить график АЧХ выделим колонку B(Y) и щелкнем по 

кнопке  – Line на панели инструментов 2D Graphs. Полученный график отредак-

тируем так же, как в предыдущих случаях. Оси абсцисс графика присвоим метку f с 

единицей измерения герцы (Гц), а оси ординат – метку A с единицей измерения 

миллиметры (мм). В итоге график должен приобрести вид, показанный на рисунке 

5.28.    

 
 

Рисунок 5.28 – График амплитудно-частотной характеристики 
 

Точно так же построим и график ФЧХ, но для его построения выделим колон-

ку C(Y) в рабочей тетради. Для возврата от окна графика к окну рабочей тетради 

можно использовать обозреватель проекта Project Explorer либо пункт Window в 

главном меню программы. Оси абсцисс этого графика тоже присвоим метку f с еди-

ницей измерения герцы (Гц), а оси ординат – метку ϕ с единицей измерения градусы 

(град.). Следует заметить, что греческой букве ϕ в кодированном обозначении соот-
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ветствует строчная латинская буква j. Завершенный график ФЧХ в итоге должен 

выглядеть так, как это представлено на рисунке 5.29. 

 

 
Рисунок 5.29 – График фазово-частотной характеристики 

 
Для построения графика АФЧХ создадим еще один проект и импортируем в 

него файл Comp_res.txt. Из заполненной рабочей тетради удалим первую колонку 

A(X), содержащую значения частоты. После этого присвоим координату X колонке 

B(Y), так чтобы ее имя приняло вид B(X). Значения в обеих оставшихся колонках, 

содержащих вещественную и мнимую часть комплексного перемещения, выражен-

ные в метрах, преобразуем в миллиметры. Завершив подготовку данных, отобразим 

их на графике. В данном случае он должен иметь, приведенный на рисунке 5.30. 

Размеры графика, параметры кривой и координатных осей зададим так же, как 

и для остальных графиков. Горизонтальной оси полученного графика присвоим 

метку Re(δ) с единицей измерения миллиметры (мм), а вертикальной оси – метку 

Im(δ) с той же единицей измерения. Для вставки в обозначение осей греческой бук-

вы δ нужно сначала ввести с клавиатуры латинскую букву d, а затем выделить ее и 

щелкнуть по кнопке  – Greek на панели инструментов Format (рисунок 5.24) либо 

применить комбинацию клавиш Ctrl+G. 
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Рисунок 5.30 – График амплитудно-фазовой частотной характеристики 
 

5.6 Контрольные вопросы 

 
1 Для чего в Origin предназначена рабочая тетрадь (Workbook)? 

2 Сколько листов (Worksheets) может содержать рабочая тетрадь? 

3 Какие способы ввода данных в рабочие тетради предусмотрены в Origin?  

4 Каким образом производится импорт числовых данных? 

5 Каким образом задаются формулы для колонок рабочей тетради? 

6 Каким образом назначаются координаты колонок рабочей тетради? 

7 Как производится удаление колонок и рядов рабочей тетради? 

8 Как производится отображение данных на двухмерном графике? 

9 Каким образом могут быть изменены размеры графика? 

10 Каким образом задаются параметры линии зависимости на графике? 

11 Как получить доступ к свойствам координатных осей графика? 

12 В чем заключаются особенности экспорта графика в файл изображения?   
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6 Лабораторная работа №6. Построение трехмерного графика 

поверхности 
 

Цель работы: ознакомление с особенностями подготовки данных для построе-

ния трехмерных графиков, изучение инструментов работы с графиками поверхно-

стей и приобретение навыков построения и редактирования трехмерных графиков в 

автоматизированной системе Origin. 

 
6.1 Подготовка данных для построения графика поверхности 

 
Графики поверхностей в Origin служат для визуализации трехмерных зависи-

мостей, т.е. графического отображения какой-либо величины, являющейся функци-

ей двух координат. Рассмотрим особенности построения таких графиков на примере 

зависимости амплитуды колебаний маятника от времени и величины коэффициента 

демпфирования. Данные, необходимые для построения этого графика, содержатся в 

пяти ранее сохраненных текстовых файлах Dyn_results20-180.txt.   

Каждый из этих файлов импортируем в отдельную рабочую тетрадь. Для этого 

в рабочую тетрадь Book1, по умолчанию присутствующую в новом проекте, сначала 

импортируем данные из файла Dyn_results20.txt. Затем добавим в проект новую ра-

бочую тетрадь (Book2), для чего просто щелкнем по кнопке  – New Workbook на 

панели инструментов Standard (рисунок 5.2). В добавленную рабочую тетрадь те-

перь импортируем данные из файла Dyn_results60.txt. Эту процедуру повторим еще 

три раза для файлов Dyn_results100.txt, Dyn_results140.txt и Dyn_results180.txt. В ре-

зультате в проекте должны присутствовать пять рабочих тетрадей с именами (Short 

Name в обозревателе проекта) Book1 – Book5.  

Для построения графика, данные в рабочих таблицах необходимо подвергнуть 

предварительной обработке, заключающейся в извлечении из каждого набора дан-

ных значений, соответствующих амплитудным пикам. При этом достаточно ограни-

читься первыми десятью амплитудными значениями для каждого набора данных. 

Это извлечение можно выполнить как вручную путем анализа данных в колонках, 

так и при помощи специальных команд доступных в пункте главного меню Analysis. 
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Но быстрее и проще выполнить его при помощи специального сценария, написанно-

го на встроенном языке программирования системы.  

Для этого, прежде всего, добавим в проект еще одну рабочую тетрадь Book6, а 

затем добавим в нее третью колонку C(Y). Добавление колонки выполним путем 

щелчка по кнопке  – Add New Columns на панели инструментов Standard (рисунок 

5.2). Также для добавления колонки можно использовать последовательный выбор 

пунктов Column → Add New Columns в главном меню либо комбинацию клавиш 

Ctrl+D. Добавленной колонке C(Y) сразу назначим координату Z (Column → Set as Z).  

После этого создадим в рабочей тетради кнопку для запуска сценария, для че-

го щелкнем по кнопке  – Text Tool на панели инструментов Tools (рисунок 5.23). 

Запустив команду, щелкнем левой кнопкой мыши в любом месте рабочей тетради 

правее ее колонок, а затем напишем какое-нибудь название кнопки, например Ex-

tract. Далее, удерживая нажатой клавишу Alt, сделаем двойной щелчок мышью по 

полученной надписи. В результате появится окно Programming Control, приведенное 

на рисунке 6.1. 

 

 
 

Рисунок 6.1 – Диалоговое окно Programming Control 
 

В многострочное текстовое поле этого окна введем программный код сле-

дующего вида: 
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n = 0; 

for (i=2;i<=399;i+=1) 

{ 

if (Book1_B[i-1] < Book1_B[i] && Book1_B[i] > Book1_B[i+1]) 

{ 

n = n+1; 

if (n <= 10) 

{ 

Book6_A[n] = 0.0075*0.2; 

Book6_A[10+n] = 0.0075*0.6; 

Book6_A[20+n] = 0.0075; 

Book6_A[30+n] = 0.0075*1.4; 

Book6_A[40+n] = 0.0075*1.8; 

Book6_B[n] = Book1_A[i]; 

Book6_B[10+n] = Book1_A[i]; 

Book6_B[20+n] = Book1_A[i]; 

Book6_B[30+n] = Book1_A[i]; 

Book6_B[40+n] = Book1_A[i]; 

Book6_C[n] = 1000*Book1_B[i]; 

Book6_C[10+n] =1000* Book2_B[i]; 

Book6_C[20+n] = 1000*Book3_B[i]; 

Book6_C[30+n] = 1000*Book4_B[i]; 

Book6_C[40+n] = 1000*Book5_B[i]; 

}; 

}; 

}; 

После ввода кода перейдем к комбинированному списку Script, Run After и 

выберем в нем пункт Button Up, а затем закроем окно кнопкой OK. В результате в 

окне рабочей тетради появится кнопка, и оно должно принять вид, примерно соот-

ветствующий рисунку 6.2. 
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Рисунок 6.2 – Окно рабочей тетради, содержащее кнопку 
 

Нажатие на созданную кнопку приведет к заполнению всех трех колонок не-

обходимыми данными, причем первая колонка A(X) будет содержать значения ко-

эффициента демпфирования, вторая колонка B(Y) – значения времени в секундах и 

третья колонка C(Z) – значения амплитудных перемещений в миллиметрах. 

На основе полученной рабочей тетради далее требуется сформировать так на-

зываемую матрицу. Матрицы в Origin, как и рабочие тетради, представляют собой 

сетку ячеек, структурированных в ряды и колонки. Главным отличием матрицы от 

рабочей тетради является то, что в тетради каждая колонка представляет собой от-

дельный набор данных и может быть настроена для хранения данных различного 

типа (текстовых, числовых и т.д.). В то время как матрица представляет собой еди-

ный числовой массив значений координаты Z, соотнесенных с координатной плос-

костью XY, заданной номерами рядов и колонок матрицы. Соответственно, матри-

цы служат для построения трехмерных графиков поверхностей, гистограмм и т.п. 

Для формирования матрицы выделим все три колонки в активной рабочей 

тетради и войдем в пункт Worksheet главного меню, а затем последовательно задей-

ствуем в нем подпункты Convert to Matrix → XYZ Gridding → Open Dialog. Это при-

ведет к появлению диалогового окна XYZ Gridding: Convert Worksheet to Matrix, 

приведенного на рисунке 6.3. 
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Рисунок 6.3 – Диалоговое окно XYZ Gridding: Convert Worksheet to Matrix 
 

Здесь сначала щелчком левой кнопки мыши развернем пункт Gridding Method 

and Parameters, а затем войдем в его верхний комбинированный список и выберем в 

нем пункт Random (Thin Plate Spline). Далее в полях Columns и Rows зададим соот-

ветственно число столбцов и рядов будущей матрицы равное 25, после чего нажмем 

кнопку OK. В результате на экране появится заполненная матрица (рисунок 6.4) 

размерностью 25×25, пригодная для построения необходимого графика поверхно-

сти. 

При этом столбцы матрицы соответствуют абсциссе, а ряды – ординате гра-

фика. Диапазон абсциссы и ординаты ограничен некоторыми значениями, заданны-

ми по умолчанию. Для того чтобы изменить эти значения войдем в пункт Matrix 

главного меню и запустим оттуда команду Set Dimensions, что приведет к появле-

нию окна, изображенного на рисунке 6.5.  

В этом окне развернем пункт Coordinates (X-column Y-row) и введем в поля 

First X и Last X начальное и конечное значение абсциссы, равные минимальному и 

максимальному значению коэффициента демпфирования, т.е.0,0015 и 0,0135 соот-
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ветственно. В поля First Y и Last Y введем начальное и конечное значение ордина-

ты, равные значениям времени на первом и десятом амплитудном пике. С учетом 

округления примем эти значения равными 0 и 5. Заполнив необходимые поля, на-

жмем кнопку OK. 

 

 
 

Рисунок 6.4 – Окно матрицы 
 

 
 

Рисунок 6.5 – Окно настройки размерности матрицы 
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6.2 Отображение данных на графике 

 
Подготовленные данные отобразим на соответствующем графике, для чего в 

главном меню последовательно выберем пункты Plot → 3D Surface → Color Map 

Surface либо щелкнем по кнопке  – 3D Color Map на панели инструментов 3D and 

Contour Graphs (рисунок 6.6). Исходный вид полученного графика поверхности при-

веден на рисунке 6.7. 
 

 
 

Рисунок 6.6 – Панель инструментов 3D and Contour Graphs 

 

 
 

Рисунок 6.7 – Исходный вид трехмерного графика поверхности 

 
6.3 Редактирование полученного графика 

 
Полученный график подвергнем модификации, связанной с изменением раз-

меров графика, внешнего вида поверхности и свойств координатных осей. Для из-

менения размеров графика запустим команду Layer из пункта Format главного меню 
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и тем самым вызовем окно Plot Details. В этом окне перейдем на вкладку Size/Speed 

(рисунок 5.15), где сначала в списке Units выберем пункт mm, а затем зададим ши-

рину (Width) и высоту (Height) графика равные 100 мм. В полях Left и Top зададим 

величины соответственно равные 60 и 50 мм, определяющие смещение графика от 

левой и от верхней границы листа. После этого снимем флажок Matrix data, maxi-

mum points per dimension в группе Speed Mode, Skip Points if needed, отвечающий за 

качество визуализации поверхности. Для просмотра сделанных изменений нажмем 

кнопку Apply. 

Далее перейдем на вкладку Miscellaneous (рисунок 6.8), где в комбинирован-

ном списке Projection выберем пункт Orthographic, что обеспечивает отключение 

перспективы на графике после нажатия на кнопку Apply.      

 

 
 

Рисунок 6.8 – Вкладка Miscellaneous окна Plot Details 
 

На следующей вкладке Axis, изображенной на рисунке 6.9, зададим длины и 

углы поворота координатных осей. При этом длины осей X и Y примем равными 

140 единицам, а длину оси Z – 100 единицам, для чего введем соответствующие 

значения в текстовые поля X, Y и Z, расположенные в столбе Length. Углы поворота 

осей зададим в текстовых полях в столбце Rotation. Значения углов пример равными 
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-21° для оси X, -20° для оси Y и 222° для оси Z. Чтобы применить сделанные изме-

нения нажмем кнопку OK. 

 

 
 

Рисунок 6.9 – Вкладка Axis окна Plot Details 
 

Выполненные преобразования приведут к тому, что две координатные оси гра-

фика будут скрыты изображением поверхности, и поэтому их необходимо переста-

вить. Для автоматической перестановки осей на панели инструментов 3D Rotation 

(рисунок 6.10) сначала нажмем кнопку  – Till down, а затем кнопку  – Till up. 

 

 
 

Рисунок 6.10 – Панель инструментов 3D Rotation 
 

Далее нужно изменить внешний вид поверхности, изображающей трехмерную 

зависимость. Для этого в главном меню программы последовательно выберем пунк-

ты Format → Plot либо просто сделаем двойной щелчок на линиях сетки поверхно-
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сти. В результате снова появится окно Plot Details с активной вкладкой Color Map 

(рисунок 6.11). 

 

 
 

Рисунок 6.11 – Вкладка Color Map окна Plot Details 

 

Здесь в поле с двумя управляющими заголовками Level и Fill щелкнем левой 

кнопкой по заголовку Level, что приведет к появлению окна Set Levels (рисунок 

6.12). В этом окне сначала нажмем кнопку Find Min/Max для автоматического опре-

деления экстремальных значений величины, откладываемой по координате Z (эти 

величины будут добавлены в поля Minimum и Maximum). Затем включим переклю-

чатель Num. of Levels и введем в соседнее с ним текстовое поле число уровней рав-

ное 100. После этого закроем текущее окно кнопкой OK и вернемся к вкладке Color 

Map, где теперь нажмем кнопку Apply. 
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Рисунок 6.12 – Диалоговое окно Set Levels 
 

Далее перейдем на вкладку Grids (рисунок 6.13), служащую для управления 

параметрами отображения линий сетки на поверхности. 

 

 
 

Рисунок 6.13 – Вкладка Grids окна Plot Details 
 

На этой вкладке в списке Enable Grids выберем пункт Both X and Y Grid Lines, 

после чего войдем в список Grid Line Width, где выберем толщину линий сетки рав-

ную 0,5 пункта. Для изменения текущего цвета линий сетки (серый) нажмем на 

кнопку справа от включенного переключателя Single и при помощи появившейся 
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палитры назначим линиям черный цвет. Чтобы применить сделанные изменения 

нажмем кнопку Apply. 

На следующей вкладке Surface/Projections (рисунок 6.14) снимем флажок Con-

tour Line и закроем окно Plot Details кнопкой OK. 

 

 
 

Рисунок 6.14 – Вкладка Surface/Projections окна Plot Details 
 

Редактирование координатных осей графика поверхности выполним так же, 

как и для двухмерного графика при помощи окна свойств осей. Для его вызова про-

ще всего сделать двойной щелчок на любой из осей графика. В этом окне сначала 

перейдем на вкладку Scale (рисунок 5.17), где для каждой оси зададим начальное 

(From) и конечное значение (To) величины и шаг ее приращения (Increment). Для 

оси X (Horizontal) примем диапазон величины от 0,0015 до 0,0135 с шагом 0,002, и 

для оси Y (Vertical) – от 0 до 5 с шагом 1. Диапазон для оси Z будет зависеть от ис-

ходных данных, в рассматриваемом примере примем его от 0 до 35 с шагом 5.  
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Нужно обратить внимание на то, что если начальное значение оси не делится 

без остатка на величину шага, то для получения на оси целого числа интервалов это 

же начальное значение необходимо указать в поле First Tick (левый нижний угол 

вкладки Scale). В данном случае это требуется сделать для оси X путем ввода в ука-

занное поле значения равного 0,0015. 

На следующей вкладке Title & Format (рисунок 5.19) в списке Major Ticks вы-

берем пункт None, а в списке Minor Ticks – пункт In. Здесь же при помощи комби-

нированного списка Major Tick Length изменим длину делительных штрихов, для 

чего выберем в нем значение равное 5 точкам. После этого установим флажки Ticks 

и Tick Length в группе Apply To и нажмем кнопку «Применить».  

Также при помощи этой вкладки нужно добавить недостающие метки осей X 

и Z. Для добавления метки оси X в поле Selection выберем пиктограмму Top, а затем 

в поле Title введем обозначение оси в виде \g(x). Далее выберем в поле Selection 

пиктограмму Back и введем обозначение оси в виде \g(d). Аналогичным способом 

изменим и обозначение оси Y (пиктограмма Right), для чего в ее поле Title введем 

метку в виде буквы t. После этого еще раз нажмем на кнопку «Применить» и перей-

дем на вкладку Grid Lines (рисунок 5.20). 

Здесь при установленном флажке Major Grids назначим линиям сетки черный 

цвет и тип линии Solid, выбрав соответствующий пункт в списке Line Type. Чтобы 

применить настройки координатной сетки для остальных осей установим флажок 

Grid Lines в группе Apply To и нажмем кнопку «Применить». 

Далее перейдем на вкладку Tick Labels (рисунок 5.21), где всех осей назначим 

шрифт Arial (список Font), размер шрифта (список Point) равный 16 точкам и полу-

жирный стиль текста (флажок Bold). После нажатия кнопки «Применить» перейдем 

на следующую вкладку Custom Tick Labels (рисунок 6.15). 

На этой вкладке сначала выделим пиктограмму Back в поле Selection, а затем 

перейдем к группе компонентов Special Ticks, где включим переключатель Hide в 

строке At Axis Begin. Благодаря этому на графике будет отключено начальное зна-

чение для оси Z.  
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Рисунок 6.15 – Вкладка Custom Tick Labels окна настройки свойств осей 
 

Завершив настройку параметров координатных осей, закроем окно настройки 

кнопкой OK и приступим к редактированию меток осей. Для этого сначала ранее 

рассмотренным способом изменим формат текста, назначив всем меткам осей 

шрифт Arial CYR, размер шрифта равный 18 точкам и полужирный стиль текста. 

Угол поворота меток примем равным нулю градусов (за выбор угла отвечает список 

Rotate (deg) в окне Object Properties на рисунке 5.22). Затем добавим меткам стрелки 

и обозначения единиц величин. При этом оси абсцисс (ξ) единицы измерения не 

требуются, т.к. коэффициент демпфирования величина выражен в относительных 

единицах, оси ординат (t) добавим обозначение с (секунды) и оси аппликат (δ) доба-

вим обозначение мм (миллиметры). В результате выполненных преобразований 

график поверхности должен приобрести свой окончательный вид, представленный 

на рисунке 6.16. 

В завершении работы сохраним проект и экспортируем график в файл изо-

бражения при помощи команды Export Graphs. В данном случае для экспорта необ-

ходимо использовать графический формат *.jpg. Кроме того, в окне настройки па-

раметров экспорта (рисунок 5.26) перед нажатием кнопки OK требуется развернуть 

пункт Export Setting и выбрать в выпадающем списке Margin Control пункт Page. 
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Рисунок 6.16 – Окончательный вид трехмерного графика поверхности 
 

6.4 Контрольные вопросы 

 
1 В чем заключается отличие матрицы от рабочей тетради Origin? 

2 Как осуществляется преобразование рабочего листа в матрицу? 

3 Каким образом задается размерность матрицы? 

4 Как создается кнопка для запуска сценария? 

5 При помощи какой команды может быть построен трехмерный график по-

верхности? 

6 Что нужно сделать для доступа к настройкам длины и углов поворота коор-

динатных осей графика поверхности? 

7 Как отключается перспектива на трехмерном графике поверхности?  

8 Каким образом осуществляется настройки цвета поверхности на графике? 

9 Каким образом производится настройка сетки поверхности? 
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7 Лабораторная работа №7. Аппроксимация двухмерных 

экспериментальных данных 
 

Цель работы: изучение инструментов системы Origin, предназначенных для 

подбора эмпирических формул, аппроксимирующих двухмерные эксперименталь-

ные данные и приобретение навыков обработки данных с использованием различ-

ных аппроксимирующих функций.   

 
7.1 Подготовка исходных данных 

 
Помимо визуализации данных, еще одной из областей применения автомати-

зированной системы Origin является аппроксимация экспериментальных данных, 

т.е. подбор алгебраических выражений, приближенно устанавливающих функцио-

нальную зависимость между рассматриваемыми данными. Причем в системе преду-

смотрена возможность аппроксимации как двухмерных, так трехмерных данных [3]. 

В обоих случаях процедура аппроксимации начинается с подготовки данных, 

которая производится точно так же, как и для построения графиков. То есть после 

создания нового проекта, прежде всего, необходимо импортировать в него иссле-

дуемые данные. В качестве первого набора данных, используем наиболее простую 

линейную зависимость из файла Stat_results.txt. 

После импорта указанных данных в рабочую тетрадь, удалим из нее первую 

колонку A, а две оставшиеся колонки B и C поменяем местами. Далее колонке С, 

содержащей значения силы, назначим координату X, а значения перемещений в ко-

лонке B переведем из метров в миллиметры. Порядок выполнения этих преобразо-

ваний рассмотрен в предыдущих работах. 

 
7.2 Аппроксимация данных линейной функцией 

 
Подготовив данные в колонках рабочей тетради, выделим обе колонки, а затем 

последовательно выберем в главном меню пункты Analysis → Fitting → Fit Linear → 

Open Dialog (выбор линейной аппроксимации объясняется тем, что исследуемые 

данные имеют явно выраженную линейную зависимость).    
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Это приведет к появлению на экране диалогового окна Linear Fit с настройка-

ми параметров линейной аппроксимации (рисунок 7.1). В этом окне развернем 

пункт Fitted Curves Plot, где найдем пункт X Data Type, правее которого располага-

ется комбинированный список. Войдем в этот список и выберем в нем пункт Same 

as Input Data, после чего нажмем кнопку OK и запустим процедуру аппроксимации 

выбранных данных. 

По ее завершению в текущую рабочую тетрадь будут добавлены еще два листа 

FitLinear1 и FitLinearCurves1 с результатами аппроксимации. При этом в листе 

FitLinear1 (рисунок 7.2) будут содержаться результаты, включающие в себя вид эм-

пирической формулы, расчетные значения ее коэффициентов, статистику решения и 

графическое представление результатов аппроксимации. 

 

  
 

Рисунок 7.1 – Диалоговое окно Linear Fit 
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Рисунок 7.2 – Рабочий лист FitLinear1 
 

Анализ данных, приведенных в этом рабочем листе, показывает, что в данном 

случае аппроксимирующая функция (Equation) имеет вид:  

 
xbay ⋅+=                                                        (7.1) 

 
Данная функция содержит два числовых коэффициента, расчетные значения 

которых составляют 4⋅10-6 для параметра A (Intercept) и 3,32806 для параметра B. 

Коэффициент A в силу своей малой величины является незначимым и его можно 

исключить из формулы. Тогда эмпирическая формула для рассматриваемого набора 

данных примет свой окончательный вид: 

 
F32806.3 ⋅=δ                                                     (7.2) 

 
Также среди результатов в этом рабочем листе следует обратить внимание на 

такой важный показатель как коэффициент детерминации (Adj. R-Square). Данный 

показатель характеризует точность аппроксимации экспериментальных данных, т.е. 

чем ближе его значение к единице, тем выше точность аппроксимации. В рассмат-

риваемом примере он равняется единице, это означает, что выбранная функция 

обеспечивает 100 % точность аппроксимации данных. 
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Второй рабочий лист FitLinearCurves1 (рисунок 7.3) содержит в себе результа-

ты в виде значений зависимой переменной, рассчитанных при помощи аппроксими-

рующей функции для каждого значения независимой переменной (колонка C(X) в 

исходных данных). Так же здесь приводятся погрешности аппроксимации для каж-

дого из этих значений. 

 

 
 

Рисунок 7.3 – Рабочий лист FitLinearCurves1 
 

7.3 Визуализация результатов аппроксимации  

 
Для более наглядного представления полученных результатов совместим на 

графике исходные данные и значения, рассчитанные при помощи аппроксимирую-

щей функции. Для этого сначала добавим в проект «пустой» график. Проще всего 

это сделать путем щелчка по кнопке  – New Graph на панели инструментов Stan-

dard (рисунок 5.2).  

Теперь чтобы добавить в этот график необходимые данные войдем в пункт 

Graph главного меню и запустим оттуда команду Plot Setup, что приведет к появле-

нию диалогового окна, приведенного на рисунке 7.4. Так же это окно можно вызвать 

при помощи двойного щелчка по серому квадрату с номером слоя в левом верхнем 

угле окна графика. 
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Рисунок 7.4 – Диалоговое окно Plot Setup 
 

В этом окне войдем в комбинированный список Available Data и выберем в 

нем пункт Worksheets in Project. Выбор данного пункта определяет то, что для по-

строения графика будут использоваться данные из рабочих листов. При этом дос-

тупные рабочие листы отобразятся в соответствующем поле, расположенном справа 

от указанного списка. В этом поле сначала выделим рабочий лист Stat_results (имя 

листа отображается в столбце Sheet), содержащий колонки с исходными данными.  

После указания рабочего листа с необходимыми данными его колонки станут 

доступными для выбора в поле, расположенном ниже. Здесь можно видеть набор 

флажков, среди которых установим флажок на пересечении столбца X и строки C, а 

также флажок на пересечении столбца Y и строки B. Такая расстановка флажков оз-

начает, что в качестве абсциссы графика будут использоваться данные из колонки C, 

а в качестве ординаты – данные из колонки B.  

Выбрав колонки, перейдем к списку Plot Type, отвечающему за форму пред-

ставления данных на графике, и выделим в нем пункт Scatter. При выборе этого 

пункта исходные данные будут добавлены на график в виде набора точек. Для до-
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бавления данных нажмем кнопку Add, после чего в поле Plot List, расположенном в 

нижней части окна должна появиться соответствующая строка.     

Далее добавим на график результаты аппроксимации, содержащиеся в  рабо-

чем листе FitLinearCurves1. Для этого выделим соответствующий пункт в списке 

доступных рабочих листов, а затем выберем необходимые колонки. В данном слу-

чае установим флажок X для колонки A и флажок Y для колонки B. Выбранные 

данные представим на графике в виде сплошной линии, для чего в списке Plot Type 

выделим пункт Line. После этого снова нажмем кнопку Add и добавим еще одну 

строку в поле Plot.  

Для непосредственного отображения данных на графике нажмем кнопку OK. 

Полученный график отредактируем так же, как это было описано ранее, и приведем 

его к окончательному виду, представленному на рисунке 7.5. 

 

 
 

Рисунок 7.5 – Графическое представление результатов аппроксимации линейной 

зависимости 

 

При этом следует обратить внимание на то, что теперь график содержит два 

независимых друг от друга набора данных, параметры отображения которых необ-

ходимо задавать отдельно. Переключение между этими наборами при редактирова-

нии в окне Plot Details осуществляется путем выбора соответствующих подпунктов 
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внутри пункта Layer, содержащегося в иерархическом списке в левой части окна 

(рисунок 7.6).   

 

 
 

Рисунок 7.6 – Доступ к различным наборам данных в окне Plot Details 
 

В рассматриваемом примере для первого набора данных (представленного 

только символами) назначим значок символа в виде зачерненного кружка без изме-

нения параметров его отображения. Для второго набора данных (представленного 

только линией) назначим тип соединительной линии Straight, стиль линии Solid и 

толщину линии равную 2 точкам. 

Очевидно, что настройки координатных осей будут одинаковыми для обоих 

наборов данных, представленных на графике.  

В завершении необходимо добавить на график легенду, содержащую инфор-

мацию о данных, представленных на графике. Для этого сначала удалим легенду, 

уже присутствующую на графике (прямоугольник в левом верхнем углу графика) и 

содержащую информацию только об одном наборе данных, а затем добавим новую 

легенду, содержащую информацию об обоих наборах. Чтобы добавить на график 

легенду щелкнем по кнопке  – New Legend на панели инструментов Graph, при-

веденной на рисунке 7.7. 

 

 
 

Рисунок 7.7 – Панель инструментов Graph 
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Содержимое легенды отредактируем точно так же, как и метки осей, т.е. сна-

чала выделим прямоугольник легенды левой кнопкой мыши, а затем правой кноп-

кой мыши вызовем контекстное меню и запустим из него команду Properties. В ре-

зультате появится окно Object Properties (рисунок 5.22), в редактируемом поле кото-

рого будут содержаться две строки. Верхняя строка будет соответствовать первому 

набору данных, а нижняя – второму набору. 

 Эти строки изменим так, чтобы первый набор данных обозначался словом 

«эксперимент», а второй набор – полученной эмпирической формулой, т.е. δ = 

3,32806F. При этом из строк нельзя удалять обозначения вида \l(1) и \l(2), поскольку 

они служат для кодирования вида графического представления данных (кружок – 

для первого набора данных и отрезок линии – для второго).  

Кроме того, нужно добавить легенде ограничивающую ее рамку. Для этого в 

комбинированном списке Background выберем пункт Black Line и нажмем кнопку 

OK. В итоге легенда графика должна выглядеть примерно так, как показано на ри-

сунке 7.5  

Завершенный график сначала сохраним в составе проекта, а затем и виде фай-

ла изображения. В данном случае для сохранения рекомендуется использовать гра-

фический формат *.png. 

 

7.4 Аппроксимация данных периодической функцией 

 
В следующем примере рассмотрим, каким образом может быть выполнена ап-

проксимация экспериментальных данных, подчиняющихся периодическому закону. 

В нашем случае такими данными являются результаты расчета колебаний маятника, 

содержащиеся в файле Dyn_results100.txt. 

Для доступа к указанным результатам добавим в текущий проект новую рабо-

чую тетрадь и выполним в нее импорт данных. В результате заполненная рабочая 

тетрадь должна содержать две колонки: колонку A(X) со значениями времени в се-

кундах и колонку B(Y) со значениями перемещений в метрах. Значения перемеще-

ний в колонке B переведем из метров в миллиметры. 



128 

Далее выделим обе колонки, а затем в главном меню программы последова-

тельно выберем пункты Analysis → Fitting → Nonlinear Curve Fit → Open Dialog. Это 

приведет к появлению специального диалогового окна (рисунок 7.8), предназначен-

ного для подбора к исследуемым данным различных аппроксимирующих функций. 

При помощи данного окна пользователь может выполнять аппроксимацию данных 

как с использованием большого числа стандартных функций, заложенных в про-

грамму, так и с использованием собственных оригинальных функций.  

 

 
 

Рисунок 7.8 – Окно настройки параметров аппроксимирующей функции 

 
Рассматриваемое окно имеет четыре вкладки, содержащих различные компо-

ненты для настройки параметров аппроксимации. По умолчанию окно открывается 

с активной вкладкой Settings, предназначенной собственно для выбора вида аппрок-
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симирующей функции и параметров аппроксимации. Причем пригодность выбран-

ной функции сразу можно оценить визуально на вкладке Fit Curve в поле просмотра 

внизу окна. Просмотр функции здесь организован в виде графика, на котором ап-

проксимируемые данные представлены в форме черных точек, а сама аппроксими-

рующая функция – в форме красной линии. 

Для выбора походящей к исследуемым данным функции сначала выберем ее 

категорию, для чего войдем в комбинированный список Category и выберем в нем 

пункт Waveform (волновая форма). Затем выберем вид функции, для чего войдем в 

комбинированный список Function и выберем в нем пункт SineDamp. Для того что-

бы обеспечить соответствие абсцисс в исходных данных и в результатах аппрокси-

мации в поле выбора, расположенном в левой части вкладки Settings, выделим стро-

ку Fitted Curves, после чего в правой части изменившейся вкладки войдем в список 

X Data Type и выберем в нем пункт Same as Input Data. 

Для вычисления коэффициентов формулы, обеспечивающих наибольшую 

точность аппроксимации, нажмем кнопку  – Fit till converged в группе кнопок, 

расположенных над полем предварительного просмотра. В итоге аппроксимирую-

щая кривая на графике должна точно совпасть с экспериментальными точками. На 

этом процедуру подбора функции можно считать завершенной, для вывода на экран 

ее результатов нажмем кнопку OK. 

Полученные результаты так же, как и в случае линейной аппроксимации, бу-

дут автоматически помещены в два рабочих листа, добавленных в исходную рабо-

чую таблицу. В данном случае они будут называться FitNL1 и FitNLCurves1.  

Анализ результатов приведенных в листе FitNL1 показывает, что подобранная 

функция обеспечивает 100% точность аппроксимации и с учетом вычисленных ко-

эффициентов для рассматриваемого примера имеет вид:  
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Данные в листе FitNLCurves1 используем для визуализации результатов ап-

проксимации, которую выполним точно так же, как и в предыдущем примере при 

помощи окна Plot Setup (рисунок 7.4). Но в рассматриваемом случае сначала доба-

вим на график не исходные данные, а результаты аппроксимации. Для этого в спи-

ске доступных рабочих листов выделим лист  FitNLCurves1 и установим флажок X 

для его колонки A и флажок Y для колонки B. Тип представления данных на графи-

ке зададим пунктом Line в поле Plot Type. 

Второй набор данных представим точками (Scatter) и для его добавления ис-

пользуем исходный рабочий лист Dyn_results100. Флажки X и Y здесь тоже устано-

вим для колонок A и B соответственно.  

После добавления обоих наборов данных на график, отредактируем его и при-

ведем к его окончательному виду, представленному на рисунке 7.9. 

 

 
 

Рисунок 7.9 – Графическое представление результатов аппроксимации 

периодической функцией 

 
При этом для изображения исходных данных используем символ в виде пус-

того кружка, а затем изменим частоту нанесения этих символов на график. Управле-

ние частотой нанесения символов осуществляется при помощи вкладки Drop Lines в 

окне Plot Details (рисунок 7.10). Активировав эту вкладку, установим здесь флажок 
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Skip Points и введем в соседнее с ним поле значение равное 5. Это означает, что на 

графике будет помечаться символом лишь каждая пятая точка.  

Для линии, изображающей аппроксимирующую функцию, назначим тип со-

единительной линии Spline, стиль линии Solid и толщину линии равную 2 точкам. 

 

 
 

Рисунок 7.10 – Вкладка Drop Lines окна Plot Details 
 

При добавлении легенды графика обозначение аппроксимирующей функции 

представим в условном виде δ = f(t), т.к. полная формула этой функции является 

слишком сложной для ее записи в легенде. 

Завершив редактирование полученного графика, сохраним проект, а затем 

экспортируем график в файл графического формата *.png.   
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7.5 Аппроксимация данных пиковой функцией  

 
 В качестве еще одного примера использования системы Origin для аппрокси-

мации двумерных данных рассмотрим, каким образом выполняется подбор эмпири-

ческой формулы для экспериментальной зависимости, имеющей явно выраженный 

пик. В данном случае такой зависимостью является АЧХ маятника, числовые значе-

ния которой сохранены в файле Amp_res.txt.  

Так же, как и в двух предыдущих случаях эти значения необходимо поместить 

в отдельную рабочую тетрадь. Для этого сначала добавим в проект новую рабочую 

тетрадь, а затем выполним в нее импорт данных из указанного файла. После импор-

та данных, заполненная рабочая тетрадь будет содержать три колонки. Так как тре-

тья колонка C(Y) содержит значения фазы, которые в данном случае не нужны, то ее 

можно удалить из рабочего листа путем запуска команды Delete из контекстного 

меню выделенной колонки. Значения амплитудных перемещений в колонке B(Y), 

выраженные в метрах переведем в миллиметры. 

Далее выделим обе оставшиеся колонки и в главном меню последовательно 

задействуем пункты Analysis → Fitting → Fit Single Peak. В результате снова появит-

ся уже знакомое окно настройки параметров аппроксимирующей функции (рисунок 

7.8). Здесь на вкладке Settings, при выбранной опции Function Selection, сразу перей-

дем к выбору подходящей функции, так как категория функции (Peak Functions) уже 

предопределена заранее и не может быть изменена. Для этого войдем в комбиниро-

ванный список Function и выберем в нем пункт Lorentz.     

Выбрав аппроксимирующую функцию, переключим вкладку Settings на оп-

цию Fitted Curves, после чего войдем в комбинированный список X Data Type и вы-

берем в нем пункт Same as Input Data. Для корректировки параметров функции на-

жмем кнопку  – Fit till converged, а затем, нажав кнопку OK,  выведем результаты 

аппроксимации на экран в форме листов fitpeak1 и fitpeakCurves1, добавленных в 

рабочую тетрадь с исходными данными.  

Как показывают результаты, приведенные в листе fitpeak1, выбранная функ-

ция обеспечивает хорошую точность аппроксимации исследуемых данных, по-
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скольку коэффициент детерминации R2 составляет 0,966. При этом полная запись 

функции с учетом вычисленных коэффициентов имеет следующий вид: 

 

( ) 22 0,378661,95611f4
0,37866186,2801221,95611A

+−⋅
⋅

π
⋅

+=                   (7.4) 

 

Нужно заметить, что при необходимости точность аппроксимации пиковой 

функцией может быть повышена. Это повышение осуществляется либо за счет ис-

пользования более сложных функций, например PearsonVII, либо за счет использо-

вания мультипиковой аппроксимации, основанной на аппроксимации данных сум-

мой нескольких пиковых функций.  

Визуализацию результатов аппроксимации выполним точно так же, как и в 

случае с использованием периодической функции на основе данных приведенных в 

листе fitpeakCurves1. Соответствующий график в своем окончательном виде пред-

ставлен на рисунке 7.11. 

 

 
 

Рисунок 7.11 – Графическое представление результатов аппроксимации пиковой 

функцией 
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При редактировании приведенного графика для точек, изображающих исход-

ные данные, изменим частоту нанесения символов, для чего на вкладке Drop Lines 

(рисунок 7.10) зададим число пропускаемых точек равное четырем. Обозначение 

аппроксимирующей функции в легенде графика опять зададим в упрощенном виде 

A = F(f). 

После сохранения всего проекта построенный график также сохраним в файл 

графического формата *.png. 

 

7.6 Контрольные вопросы 

 

1 Что называется аппроксимацией экспериментальных данных? 

2 Каким образом в системе Origin осуществляется аппроксимация двухмерных 

данных линейной функцией? 

3 Каким образом в системе Origin осуществляется аппроксимация двухмерных 

данных нелинейной функцией? 

4 В какой форме в системе Origin выводятся результаты аппроксимации дан-

ных? 

5 Каким образом производится совмещение различных наборов данных на од-

ном графике? 

6 Как производится добавление и редактирование легенды графика? 
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8 Лабораторная работа №8. Аппроксимация трехмерных 

экспериментальных данных 
 

  Цель работы: изучение инструментов системы Origin, предназначенных для 

аппроксимации экспериментальных данных, являющихся функцией двух независи-

мых переменных; приобретение навыков подбора эмпирических формул для трех-

мерных наборов данных. 

 

8.1 Подготовка исходных данных 

 

Особенности аппроксимации трехмерных данных рассмотрим на примере экс-

периментальной поверхности, построенной при выполнении лабораторной работы 

№6. Так как процесс подготовки данных для построения поверхности является не-

сколько трудоемким, то проще воспользоваться уже готовыми данными, содержа-

щимися в ранее сохраненном проекте. Для доступа к этим данным откроем проект, 

созданный при построении поверхности и активируем в нем окно матрицы, содер-

жащей числовые значения.  

Эту матрицу сохраним в отдельный файл, для чего войдем в пункт главного 

меню File и запустим оттуда команду Save Window As. Запуск команды приведет к 

появлению стандартного диалогового окна сохранения файлов, при помощи которо-

го нужно задать директорию и имя сохраняемого файла с расширением *.ogm.   

После сохранения файла создадим новый и проект и добавим в него сохранен-

ную матрицу. Для этого войдем в пункт главного меню файл File и запустим коман-

ду Open либо просто щелкнем по кнопке  – Open на панели инструментов Stan-

dard. В появившемся стандартном диалоговом окне при помощи комбинированного 

списка «Тип файлов» установим фильтр выбора Matrix (*.ogm), а затем укажем тре-

буемый файл и откроем его.    

В результате в текущий проект автоматически добавится матрица с данными, 

готовыми для выполнения дальнейших операций.   
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8.2 Выбор аппроксимирующей функции 

 

Для выбора аппроксимирующей функции при активном окне матрицы войдем 

в пункт Analysis главного меню и на этот раз последовательно задействуем его под-

пункты Nonlinear Matrix Fit → Open Dialog. Это приведет к появлению диалогового 

окна, аналогичного окну, приведенному на рисунке 7.8, но настроенного на аппрок-

симацию поверхностей, что показывает предопределенная категория Surface Fitting.  

Предварительный перебор стандартных функций, заложенных в программу, 

показывает, что ни одна из них не обеспечивает достаточной точности аппроксима-

ции рассматриваемого набора данных. Поэтому здесь воспользуемся пользователь-

ской функцией, которую создадим при помощи редактора функций. 

Для входа в этот редактор щелкнем по кнопке  – Create/Edit Fitting Func-

tions, расположенной в группе кнопок над полем просмотра в текущем окне. Диало-

говое окно редактора приведено на рисунке 8.1. При помощи инструментов этого 

окна теперь необходимо создать пользовательскую функцию, которая обеспечит 

приемлемую точность аппроксимации.  

 

 
 

Рисунок 8.1 – Окно редактора аппроксимирующей функции 
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Проще всего создать такую функцию на основе уже имеющихся стандартных 

функций, список которых отображается в левой части окна редактора. Для этого 

среди доступных здесь функций выберем функцию с названием Poly2D, а затем на-

жмем на кнопку Duplicate в правой части окна. В результате в список функций по-

следним пунктом будет добавлена новая функция CopyOfPoly2D, представляющая 

собой копию выбранной стандартной функции. 

Выделим эту функцию в списке и выведем ее параметры в центральную часть 

окна. При этом математическое выражение функции будет показано в поле Function. 

По умолчанию оно должно иметь следующий вид: z=z0+a*x+b*y+c*x^2+d*y^2+ 

+f*x*y. Приведенное выражение дополним еще двумя слагаемыми так, чтобы оно 

приняло вид: z=z0+a*x+b*y+c*x^2+ +d*y^2+f*x*y+g*x^2*y^2+h*x^3*y^3 (в конце 

записи выражения необходимо поставить точку с запятой). После этого перейдем к 

текстовому полю Parameter Names и через запятую добавим к присутствующим там 

параметрам обозначения g и h. Для сохранения сделанных изменений нажмем кноп-

ку Save, а затем нажмем кнопку OK и закроем окно редактора функции. 

Подготовив необходимую функцию, настроим параметры вывода результатов 

аппроксимации, для чего активируем опцию Fitted Curves на вкладке Settings. Здесь 

развернем пункт X Data Type и введем в текстовое поле Points размерность матрицы 

результатов равную 25. Так как для вывода результатов по умолчанию используется 

квадратная матрица, то такая же размерность будет автоматически задана и в анало-

гичном поле внутри пункта Y Type Data.   

Процедура коррекции параметров аппроксимирующей функции выполняется 

точно так же как и для двухмерных данных путем нажатия на кнопку  – Fit till 

converged с последующим нажатием на кнопку OK для вывода результатов.  

При этом для вывода результатов, включающих вычисленные коэффициенты 

эмпирической формулы, статистику решения и т.п., в проект автоматически будет 

добавлена рабочая тетрадь Analysis Report 1 с единственным листом fitmatrix1. Про-

смотр приведенных здесь результатов показывает, что для рассматриваемого приме-

ра формула аппроксимирующей функции с учетом вычисленных коэффициентов 

примет вид: 
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3322

22

t7253379,523t733725,1494t1456,89359
t0,11185845043,9758t1,565361298,172435,1407A

⋅ξ⋅−⋅ξ⋅+⋅ξ⋅−

−⋅+ξ⋅+⋅−ξ⋅−=
     (8.1) 

 

Коэффициент детерминации R2 равный 0,998 показывает, что полученная 

формула с высокой степенью точности описывает форму исследуемой эксперимен-

тальной зависимости. 

Значения амплитуды, вычисленные при помощи аппроксимирующей функ-

ции, и их абсолютные погрешности будут приведены в исходной матрице в двух до-

полнительных листах fitmatrixCurves1 и fitmatrixResiduals1. 

 

8.3 Визуализация результатов аппроксимации 

 

Полученные результаты аппроксимации отобразим на трехмерном графике. 

При этом значения, вычисленные при помощи подобранной функции, представим в 

виде поверхности, а экспериментальные значения представим в виде набора точек.  

Для построения такого графика необходимо, чтобы экспериментальные значе-

ния содержались в рабочей тетради, в то время как на текущем этапе они содержат-

ся в матрице. Поэтому сначала требуется переместить данные из матрицы в рабочую 

тетрадь. Для того чтобы выполнить эту операцию выведем на экран исходную мат-

рицу и активируем ее первый лист (Gridding Matrix). 

После этого войдем в пункт главного меню Matrix и последовательно задейст-

вуем его подпункты Convert to Worksheet → Open Dialog, что приведет к появлению 

диалогового окна Data Manipulation\Gridding (рисунок 8.2). 

В этом окне войдем в комбинированный список Method и выберем в нем 

пункт XYZ Columns, после чего нажмем кнопку OK. В результате в проект будет ав-

томатически добавлена и выведена на экран рабочая тетрадь с необходимыми дан-

ными, сгруппированными в три колонки (X, Y и Z). 
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Рисунок 8.2 – Диалоговое окно Data Manipulation\Gridding 
 

Полученные данные теперь отобразим на графике. Для этого левой кнопкой 

мыши выделим все три колонки, а затем последовательно выберем пункты главного 

меню Plot → 3D XYZ → 3D Scatter и построим трехмерный график, где выбранные 

данные изображены в виде набора точек.  

На построенный график далее добавим поверхность, изображающую расчет-

ные значения, для чего при активном окне графика войдем в пункт главного меню 

Graph и запустим оттуда команду Plot Setup. В одноименном окне (рисунок 7.4), вы-

званном указанной командой, в списке Available Data выберем пункт Matrices in Pro-

ject и выведем список доступных матриц. В этом списке выберем лист (Sheet) с на-

званием fitmatrixCurves1, после чего в поле выбора доступных в выбранной матрице 

данных установим флажок Z. Для определения формы представления данных на 

графике в списке Plot Type выберем пункт 3D Color Fill Surface. Для непосредствен-

ного добавления данных на график последовательно нажмем кнопки Add и OK.          

Полученный в итоге график отредактируем так же, как это было описано в ла-

бораторной работе №6. Для этого вызовем диалоговое окно Plot Details, при помощи 

которого сначала зададим размеры графика, его положение, длины и углы поворота 

координатных осей. Затем зададим параметры отображения данных представленных 

на графике. При этом изображение первого набора данных, представленного точка-

ми изменять не будем, а для второго набора данных, представленного поверхно-

стью, внесем ряд изменений.  
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При выбранном способе построения поверхности (3D - Color Fill Surface) па-

раметры ее отображения будут сгруппированы на двух вкладках (Grids и Side Walls) 

окна Plot Details. В данном случае ограничимся редактированием параметров на 

вкладке Grids, содержимое которой (рисунок 8.3) будет несколько отличаться от 

аналогичной вкладки, уже рассмотренной для поверхности построенной с использо-

ванием способа 3D - Colormap Surface. Здесь в комбинированном списке Enable 

Grids выберем пункт Both X and Y Grid Lines, в списке Grid Line Width зададим 

толщину линий сетки равную 0,5 пункта. Далее при помощи кнопки Grid Color на-

значим линиям сетки черный цвет, а при помощи кнопки Front Color назначим са-

мой поверхности светло-серый цвет (LT Gray). После этого нажмем кнопку OK. 

 

 
 

Рисунок 8.3 – Вкладка Grids для поверхности, построенной с использованием 

способа 3D - Color Fill Surface 

 
Для приведения графика к его окончательному виду изменим параметры ко-

ординатных осей, включая диапазоны, откладываемых по осям величин, параметры 

отображения делительных штрихов, параметры отображения координатной сетки и 

обозначений осей.  
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При добавлении легенды первый набор данных, изображенный на графике в 

виде точек, обозначим как «эксперимент», а второй набор данных, изображенный в 

виде поверхности обозначим условной записью аппроксимирующей функции вида δ 

= f(ξ,t).  

В результате завершенный график должен выглядеть так, как показано на ри-

сунке 8.4. Этот график так же, как и все предыдущие графики сохраним в файл гра-

фического формата *.png либо *.jpg. 

 

 
 

Рисунок 8.4 – Графическое представление результатов аппроксимации трехмерных 

данных 
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8.4 Контрольные вопросы 

 
1 Каким образом выполняется перенос дочерних окон из одного проекта в 

другой проект Origin? 

2 При помощи какой команды осуществляется доступ к аппроксимирующим 

функциям для трехмерных данных? 

3 Каким образом может быть создана пользовательская аппроксимирующая 

функция? 

4 В какой форме выводятся на экран результаты аппроксимации трехмерных 

экспериментальных данных? 

5 Как осуществляется преобразование матрицы в рабочую тетрадь? 
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Приложение А 
(обязательное) 

 

Исходные данные для выполнения лабораторных работ 
 

Параметры модели  
Вариант 

 Диаметр 
витка 

пружины 
d, мм 

Диаметр 
сечения 
витка 
dW, мм 

Осевой 
шаг  

витков 
S, мм 

Число 
витков 

N 

Масса 
груза 
m, кг 

1 35 2 8 15 2 

2 30 1 10 12 1,5 

3 20 1 5 20 1,5 

4 35 2 10 12 3 

5 40 2,5 12 12 4 

6 30 1,5 5 16 2,5 

7 25 1 8 15 3 

8 35 1,5 10 15 3 

9 20 1,5 8 12 2,5 

10 40 2 15 12 3,5 

11 25 1 5 16 2 

12 30 2 12 14 2,5 

13 30 2,5 15 10 4 

14 35 1 8 18 2 

15 32 1,5 10 15 3,5 
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Приложение Б 
(справочное) 

 
Пример оформления отчета по лабораторным работам 
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Рисунок Б.1 – Расчетная схема маятника 
 

Физические свойства материала пружины: 

- модуль упругости E = 2,1 ⋅ 105 МПа; 

- коэффициент Пуассона µ = 0,3; 

- коэффициент демпфирования ξ = 0,0075. 

Физические свойства материала цилиндра: 

- модуль упругости E = 2,1 ⋅ 105 МПа; 

- коэффициент Пуассона µ = 0,3; 

- объемная плотность (расчетная) ρ ≈ 7424 кг/м3. 

 

 

 

 

Лист

 



147 

 
 

Рисунок Б.2 – Сеточная модель маятника 
 

 

 
 

Рисунок Б.3 – Контурный график перемещений вдоль оси пружины Лист
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Рисунок Б.4 – График зависимости удлинения пружины от нагрузки 

 

Расчетная жесткость пружины: мм/Н189,0
8,105

20K ≈=  

 

 
Рисунок Б.5 – График зависимости перемещения от времени 

 

Расчетный период колебаний: T = 0,64 с 

Расчетная частота колебаний:  Гц56.1
64,0
1f ≈=  

Лист
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Рисунок Б.6 – График амплитудно-частотной характеристики 
 

 
 

Рисунок Б.7 – График фазово-частотной характеристики 
 

Лист
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Рисунок Б.8 – График амплитудно-фазовой частотной характеристики 
 

 
 

Рисунок Б.9 – Поверхность амплитудных перемещений маятника 
 Лист
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Рисунок Б.10 – График линейной аппроксимирующей функции 

 
Коэффициент детерминации: R2 = 1 
 

 
Рисунок Б.11 – График периодической аппроксимирующей функции 

 

Математическое выражение функции с учетом вычисленных коэффициентов: 

⎟
⎠

⎞
⎜
⎝

⎛ −
⋅π⋅⎟

⎠

⎞
⎜
⎝

⎛
−⋅+⋅−=δ

0,32308
0,31961tsin

2,77939
texp17,92706103,04763 4-  

Коэффициент детерминации: R2 = 1 
Лист
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Рисунок Б.12 – График пиковой аппроксимирующей функции 
 

Математическое выражение функции с учетом вычисленных коэффициентов: 

 

( ) 22 0,253651,55524f4
0,25365249,11166220,61733A

+−⋅
⋅

π
⋅

+=  

 
Коэффициент детерминации: R2 = 0,963 

Лист
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Рисунок Б.13 – График аппроксимирующей поверхности 
 

Математическое выражение функции с учетом вычисленных коэффициентов 

 

3322

22

t349310,1546t9500,17475t647,89072
t0,03111615,3197t0,301461,5721817,22609A

⋅ξ⋅−⋅ξ⋅+⋅ξ⋅−

−⋅+ξ⋅+⋅−ξ⋅−=
 

 

Коэффициент детерминации: R2 = 0,998 

 

 

 

 

Лист

 


